User’s
Manual TA320/TA520/TA720
Optical Disk Inter-Symbol Interference
Analysis Software
IM 704223-61E
A
YOKOGAWA ’ IM 704223-61E

. . 1st Edition
Yokogawa Electric Corporation



Product Registration

Thank you for purchasing YOKOGAWA products.
YOKOGAWA provides registered users with a variety of information and
services.
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Thank you for purchasing the Optical Disk Inter-Symbol Interference Analysis Software
(704223) for the TA320/TA520/TA720 Time Interval Analyzer.

This user’s manual contains useful information about the functions, operating
procedures, and handling precautions of the software. To ensure correct use, please
read this manual thoroughly before beginning operation.

After reading the manual, keep it in a convenient location for quick reference whenever a
question arises during operation.

For information about the functions, operating procedures, and handling precautions of
the TA320/TA520/TA720 Time Interval Analyzer and the handling and operating
procedures of Windows, see the respective manuals.

Contents of the Package

Notes

Trademarks

Revisions

Disk No. HF10
1st Edition: January 2003 (YK)

.

.

.

Software Installation CD-ROM: 1 piece

TA720 Firmware Upgrade Floppy Disk: 1 piece
User’s Manual (this manual): 1 piece
Precautions When Using the TA720: 1 sheet

To analyze the measured data of the TA720 using this software, the ROM version
of the TA720 must be 1.02 or later. You can check the ROM version of the TA720
in the Version Information dialog box that appears by selecting Utility > Version
on the TA720.

The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the software’s performance and functions. The figures
given in this manual may differ from the actual screen.

Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.
Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA’s permission is strictly prohibited.

Microsoft, MS-DOS, and Windows are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

For purposes of this manual, the TM and ® symbols do not accompany their
respective trademark names or registered trademark names.

Other company and product names are trademarks or registered trademarks of their
respective companies.

1st Edition  January 2003

All Rights Reserved, Copyright © 2003 Yokogawa Electric Corporation
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE

Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the
“Yokogawa Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached. Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa
or those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT
TO YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License

Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.

You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.

Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.

Licensed Software Name: TA320/TA520/TA720 Optical Disk Inter-Symbol Interference Analysis Software

Number of License: 1

Article 1 (Scope Covered by these Terms and Conditions)

1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the
Licensee consents to agree to the terms and conditions stipulated herein.

1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary
technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)

2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the
license fee separately agreed upon by both parties.

2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the
Licensed Software.

2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes. The Licensee shall
secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.

2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee
may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software. Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights. In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.) In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)

3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for
the purpose of the following events:

a) Operation of any aviation, vessel, or support of those operations from the ground;,

b) Operation of nuclear products and/or facilities;,

c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)

4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such
as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility
within seven (7) days after opening the Package at the Licensee’s expense. As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.
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Terms and Conditions of the Software License

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.

Article 5 (Infringement)

5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under
patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party. Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa’s defense and negotiation. If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa'’s cost and expense.

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use
the Licensed Software;

b) To replace the Licensed Software with an alternative one which avoids the infringement; or

¢) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee. THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)

6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided
to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement. However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received. Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)

This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa'’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)

During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement. However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)

Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)

This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.
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Explanation of Functions

Functional Overview

This software application is capable of analyzing the inter-symbol interference of the data
measured by the TA320/TA520/TA720 Time Interval Analyzer using the following two
methods. In addition, the result of the analysis can be printed to a printer that is
connected to a PC.
¢ Histogram Analysis
In this method, data that matches the specified conditions is extracted, and the

histogram and a list of statistics are displayed.
Pata to data All Space Stafisfics
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e Matrix Analysis
In this method, data that matches the specified conditions is extracted and the level of
interference between adjacent data points is displayed using a two-dimensional matrix
table (sheet (numeric values) or graph).
Graph display (bar graph) example

Pata to data Deviation Matiix of Infer—Symbcel fnferference
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Loading of Measured Data
You can load the measured data to be analyzed using the following methods.

Fositive Error

Good

Upper horder 10.000{n=s)

Lower horder-10.000({n=s)

Megative Errar

» Open the measured data saved to an external storage medium.
» Connect the Time Interval Analyzer and the PC via the GP-IB interface and load the
measured data by starting the measurement from the software.

You can also load the measured data using the following method on the TA720.

» Connect the Time Interval Analyzer and the PC via the Ethernet network and load the
measured data by starting the measurement from the software.
» Save the measured data on a PC hard disk operating as a network drive (FTP server)

via the Ethernet network and open the saved data.

» Access the measured data stored on an external storage medium connected to the
TA720 using an FTP software tool (not included in this software package) on the PC,

save the data on the PC, and open the data.

Vi
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Explanation of Functions

Setting the Number of Times to Load the Data
If the same model is used under the same measurement conditions, multiple sets of
measured data (measured data of multiple files) can be loaded and accumulated.
Maximum number of times the data can be loaded: 64 (except the maximum number of
data points that can be loaded is 2 Mpoints)
Measurement Conditions of Measured Data That Can Be Loaded
+ TA320/TA520
Sampling mode: Time stamp
Measurement function: Pulse width (both polarities) measurement
« TA720
Sampling mode: Inter-symbol interference analysis
Measurement function: Pulse width, pulse width A—A-to-B time interval, or pulse width
A—pulse width B

Setting the Analysis Conditions
After loading the measured data, you set the data polarity, modulation type, window, and
other parameters.

¢ Polarity/Modulation Setup Dialog Box
Ar [ x|

Polarits
i«
(ol

—Madiulation
© BATCEFM: 3T-=11T)
{3 B-1B( EFM-Plus: 3T=11T,14T )

pace - Wark
Mark - : Space

170 2T=8T )
© Manual

—Select T (Manuial)

Fhr Fs Mear s
Kz Fer Fiol &g
Flar Fm Rl
Fan Fear  Flon

¢ Window Setup Dialog Box
Wi g Dialog x|
~Space Window ~Mark Window Size Adjustment

& Center,Span © Left Right

=57 ns Space Update; T=|37 NS Mark Updalel
~Easy T Sefting
Base [hone »| certer [57 ns ||| Base [one v Center [57 ns Wi
Center (ns) Sgan (ns) Center (r1s) Span (ns) ((: ;I\JIDIUsEr
37 & ns

at [ 111 - [185 at [111 - [183 - Dtz
47 [148 - [1s 41 [148 = [1es

18| 2 | x| e | 8x
57 [18s - [1s 5T [185 = [1es

125 | 18 | 2 | 20 |3z
87 [ 222 - [1s 6T [222 = [1es

a0y | 48
77 [ 258 - [1s 71 [ 259 = [1es
o7 [ 286 - [185 o7 [ 296 - [183 HsER i
a1 [ 333 - [185 a7 [333 - [183 [
101 [ 370 - [185 107 [ 370 - [183 T=[— =
11T|4D? +- |1ss 11T|4D7 +e |1ss Copy Estimater Tta T

Deviation Option

147 |513 +- |135 14T|518 + 185 | [ | Cancel |

Setting the Display of Analysis Results

Select whether to display the results in a histogram or matrix. You can also select the

following display options in each display.

¢ Histogram Display
Select whether to display only the histogram or both the histogram and a list of
statistics. For the statistics, you can select to display the average, the deviation (the
deviation of the measured average value with respect to the Center value), the jitter,
and/or the number of computed samples.
You can also switch the histogram color and the histogram vertical scale (Linear or Log).
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Explanation of Functions

« Example when only the histogram is displayed

Data to Data All & Selected Space Histogram —mAl
oo —=—Gelected
Left
Right
Center
Average
10
1
aT 4T 5T BT T aT aT 10T T 14T
« Example when both the histogram and statistics are displayed
Data fe data All Space Stafistics
Stat~—. T T 4T T 6T T a7 aT 10T 11T 14T
Awe.lns] 108.562 148.918 182.595 218.755 257.419 206,378 332631 370032 406,347 518.087
Dev[ns] -1.438 0.918 -2.405 -3.245 -1.4881 0378 0.631 0.082 -0652 0.087
Jitterns] 5.242 4.020 3.956 3.820 4.015 713 3542 3883 2.081 2370
Murm 1576 1212 320 591 354 215 137 7 k) 2
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Sté?‘\ T 3T T T BT T 8T a7 10T 1T 14T
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Dev.[ns] 0.430 1.879 -1.822 -2.814 -0.485 1212 1378 1.088 -0.413 ---
Jitter[ns] 5.224 4.109 4.078 4127 4N7 3363 4342 3453 3488 ---
MNum 573 401 229 178 119 50 34 21 2 1]
Data to Data All & Selected Space Histogram —mAl
0o, —=—gelected
Left
Right
Center
Average

e Matrix Display
Select whether to display the statistics on a sheet or a graph. You can select to display
the statistics of the average, the deviation, or the jitter.
On the deviation and jitter graph displays, you can switch the display shape (Bar,
Rectangle, or Pie), set the threshold levels (2 points), and set the colors for the three
sections created by the threshold levels.

» Example when statistics are displayed on a sheet

Data fo data Average Matrix of Infer—Symbol Interference

=T T 4T T &7 T &7 ar 107 1T 147 =T
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Explanation of Functions

+ Example when the statistics are displayed on a graph

Pata to Data Deviation Malrix of Infer—Symbol fnfetference

T ave

“ertical line | 4T
WTx2
XTx 2
e
Horizortalline

Setting the Data Extraction Conditions
Set the data extraction conditions on the loaded measured data using a setup bar
(referred to as the Trigger Bar) as shown in the figure below.

Trger [ gpace |4l | @ e [an | ™ space [41 =] omane e [ e
cha —_I_I
c ¥ | Phase| 000 j ns

che " o ©
Use Trigger to select Space or Mark (the trigger used to extract the data) and Ch A or Ch
B to specify the data to be extracted.
The data extraction conditions vary depending on whether histogram analysis or matrix
analysis is being performed as follows.
¢ Histogram Analysis
If the loaded measured data is pulse width, the following types of data extraction are
possible.
» Use a Space or Mark as a trigger and extract the Mark or Space around it.
(The extraction mode setting of the inter-symbol interference analysis on the TA is Single.)

Mark Space Mark Space Mark Space Mark Space Mark
i) (7 o () (37
i T@er l TEger i T@er

| Extract the Mark data before the 3T Space ‘

+ Use the combination of a Mark followed by a Space or a Space followed by a Mark
as a trigger and extract the Mark or Space around it.
(The extraction mode setting of the inter-symbol interference analysis on the TA is
Combination.)

Mark Space Mark Space Mark Space Mark Space  Mark
() v () o (31 o (056 (750
i Trigger l Trigger

Extract the Mark data before the combination of the 3T
Space followed by the 7T Mark

» Use a Mark or Space in between two Spaces or two Marks as a trigger and extract
the data between two Spaces or the Mark or Space in between two Marks.
(The extraction mode setting of the inter-symbol interference analysis on the TA is

Between.)
Mark Space Mark Space Mark Space Mark Space Mark Space Mark Space Mark
3T3T6T[ 141 ]3T[7T ]3T[6T]4T
%Triggerj _%Trigger_

| Extract the Mark data in between two 3T Spaces |

If the loaded measured data is “pulse width—pulse width”, you can use a Mark
followed by a Space or a Space followed by a Mark on Ch A as a trigger and extract
the Mark or Space around it on Ch B.
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Explanation of Functions

If the loaded measured data is pulse width—A-to-B time interval, the following types of

data extraction are possible.

» Use a Space or Mark as a trigger and extract the A-to-B time interval from the front
edge, back edge, or both edges.
(The extraction mode setting of the inter-symbol interference analysis on the TA is
Single.)

Space Space Space Space
Mark Mark Mark Mark Mark
ChA T 11 [of] ur [rfetleT] 141 3777
Trigger Trigger | Trigger
ChB ! w |
| | |
Extract the A1'B| data from the front edge of the
3T Space

+ Use the combination of a Mark followed by a Space or a Space followed by a Mark
as a trigger and extract the A-to-B time interval from the front edge, back edge, or
middle edge.

(The extraction mode setting of the inter-symbol interference analysis on the TA is
Combination.)

Space Space Space Space
Mark Mark Mark Mark Mark
ChA T w1 [t 111 [sifarleT [ 14T s 77
Trigger | Trigger |
chB ; 1
| |

Extract the A1B/ data from the back edge of the 3T Space
after the 11T Mark

» Use a pair of Spaces that embraces a Mark or a pair of Marks that embraces a
Space as a trigger and extract the A-to-B time interval from the front edge, back
edge, or middle edge of the Mark or Space embraced by the trigger.

Space Space Space Space
Mark Mark Mark Mark Mark

ChA T 11 [t 111 [sifarleT [ 141 |3 77
L_Trigger -
chB ) |

| !

Extract the AlB? data from the edge on each end of the
Mark in between two 3T Spaces

Matrix Analysis

If the loaded measured data is pulse width, you can select whether to extract the
Space-Mark or Mark-Space data immediately before the trigger or after the trigger by
using either a Space or Mark as a trigger.

Mark Space Mark Space Mark Space Mark Space  Mark
3T 3T 67| 141  |3T| 71
1 1 Trigger l l Trigger

| Extract the Mark-Space data immediately before the 7T Mark\

If the loaded measured data is pulse width—pulse width, you can select whether to
extract the Space-Mark or Mark-Space data of Ch B immediately before the trigger or
after the trigger by using either a Space or Mark of Ch A as a trigger.
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Explanation of Functions

If the loaded measured data is pulse width—A-to-B time interval, the following types of

data extraction are possible.

» Use a Space or Mark as a trigger and extract the A-to-B time interval from both
edges (one edge if the slope of the measured data is either edge) of a Mark or
Space immediately around the trigger.

Space Space Space Space
Mark Mark Mark Mark Mark

ChA T nr [orf nr [21farleT [ 141 2177

Trigger | Y-axis :X-axis

che ULV Uy

ha g B
| {
Extract the A}B1 data from the edge on each end of the
Mark after the 3T Space

» Use a Mark or Space in between two Spaces or two Marks as a trigger and extract
the A-to-B time interval from both edges.

Space Space Space Space
Mark Mark Mark Mark Mark

ChA T ur [if nur Ppifarler [ 1a1 3177

Y-axis ' Trigger ' X-axis

Extract the A} B! data from the edge on each end of the
11T Mark

In addition, you can also extract the A-to-B time interval from an edge embraced
between a Space and a Mark or a Mark and a Space.

T symbol of Space/Mark to Be Used as a Trigger

You can select from the following.

All, 1T to 14T, Min. T-1T to Min.T-14T, 1T-Max.T to 14T-Max.T, ODD, and EVEN

If you select Min. T-1T to Min.T-14T, all the symbol from the smallest symbol to 1T to 14T
symbol will be used as triggers to perform the analysis. Similarly, if you select 1T-Max.T
to 14T-Max.T, all the symbol from 1T to 14T symbol to the maximum symbol will be used
as triggers to perform the analysis. ODD denotes all odd Ts and EVEN denotes all even
Ts.

Saving/Loading of Data

You can save and load the setup data of the software, the retrieved measured data, and
the center value of deviation specified arbitrarily (see page 2-4). In addition, you can
save the statistical data (statistics of the extracted data, trigger statistics of all the data,
and statistics of matrix analysis) to a file in CSV format.

Printing of Analysis Results

Other Functions

You can print in monochrome or in color the histogram analysis results (histogram and a
list of statistics) and the matrix analysis results (sheet and graph).

Phase Adjustment

Phase adjustment in the range of —99.99 ns to 99.99 ns is possible with respect to the
measured data of “pulse width A—A-to-B time interval” of the retrieved TA720.

Entering Comments

You can display a comment text on the analysis result screen.

Displaying a List of the Loaded Measured Data

You can display the file path of the loaded measured data (drive letter, directory, and file
name) and the communication path (GPIB or Ethernet).
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Functions of the Main Window Components and a
List of Menus

Functions of the Main Window Components

Menu

For details on
each menu, see
the next page.

Toolbar

Trigger bar 4[

Model and
measurement
conditions of the
measured data
load source

Number of
measured data
points

Number of
measured data
accumulations and
the specified
accumulations
(see section 1.1)

Load the measured data from files (File > Open)
Load the measured data via the communication interface (File > Open From Communication)

Setup  iew

Loading of the measured data and analysis results (File > Load Measured & Setup Data)
Save the measured data and analysis results (File > Save Measured & Setup Data)
Print (File > Print)

Set up printing (File > Print Setup)
Print preview (File > Print Preview)
Clear the measured data and analysis data (Setup > Clear Data)

Corresponding menu item is
indicated inside the parentheses.

Histogram display (View > Histogram)
Matrix display (View > Matrix)
Display the graph and a list of statistics of the histogram analysis
(View > Histogram & Table)
Display only the graph of the histogram analysis (View > Histogram Graph)
Display all data of the histogram analysis (View > All Graph)
Display the sheet analysis results of the average
(View > Statistics Average)
Display the sheet analysis results of the deviation
(View > Statistics Deviation)
Display the sheet analysis results of the jitter
(View > Statistics Jitter)
Display the graph analysis results of all measured data
(View > Graph)
Display the graph analysis results of the deviation
View > Bar Deviation)
Display the graph analysis results of the jitter
(View > Bar Jitter)

Display the pulse width data of the matrix analysis
(View > Pulse Width)

Display the A-to-B time interval data of the matrix
analysis (View > Time Interval)

Set the window (Display > Window)

Display the software version, etc.
(Help > About)

}‘ﬁ

__—Set the Mark/Space to
be used as a trigger

ICEARSDE & BE L e e

s S b ol P 1 [ B[ 2 |

(See sections 3.2 and 4.2)

Trgger  J—mgare [ T evak |51 =] T enae JAl e JAr——>|

ChA
Che 1]

Wiy

[camak— Execute the Analysis

VR ase =
rrase 00 uey Adjust the phase

TA720 PulseWidth&Timelnterval, ChA ChB Rise—>Rise
10000 Sample Data Accumulation 1/ 1

Data fo dafa Devj;&fgn Matrix of Inter—Symbol Interference
Ed T [ o BN

(See sections 3.2 and 4.2)

i AT T T "r 14T WT \
S| S T | S| o | e | o | e | ks | s Set the extracted data
AR R R R Fr ;

N R R A A R R A P (See sections 3.2 and 4.2)
i T | | | T | | | | ] | [ rvatmeen |7 o

13 15 146 % ] S E 12 i 1 o YT HamEe T NAMDE TS T \
/ 52 | Lk e 1% N0 | Z0@ | 2ms | iEe | -4 | a0 — E I t t

1Ee [ 1m0 1292 | 2niz | a2 2451 2 -] 26% ) 5175 p

il e = s e Il il sl I Xplanatory notes

ST 2.3 -2 01 FETY -45ig - B 25 - BT 1

A A A e O I R I (See sections 3.1 and 4.1)
Bl I e e e e I e R

o | ar | | e e [ [ e e

A R I I I I N R IR

ol I I e e e I il el Il

wr | am | m || ame | | e | wms [ |

A A I R Bl I ) I

BT 128 a7 1118 20 OEH -0 4 -

- B I I I el - B

ar ErES oan 122 1204 =1 =IE 535 -3 - -

N I - I I e B B el

1T 0Es oms nis2 [ 135 - -

O I I R IR el Il el el

1T - -{om B - - - - - -

Display of the analysis results

xii
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Functions of the Main Window Components and a List of Menus

A List of Menus

File Menu (File and Print Settings)

Load the measured data from files (see section 1.3)

Load the measured data via the communication
interface (see section 1.2)

& Open. G List the loaded measured data (see section 1.4)
%‘ Open Fram Communication... Citrl+G L. )
Save the statistical calculation results of the extracted
Comm / Data File List.. Ctrkl data of histogram analysis (see section 5.1)
Save Statistics (Triegered Ti. CtreT Save the statistical calculation results of all data of
Save Statistics (81l Trigeered Ti.. Cirl+f — histogram analysis (see section 5,1)
Save Matrix Statistics.. Cirl+M — - . . .
ave Tel SEetes " T Save the statistical calculation results of matrix analysis
Save Setup Data.. Cirl+5 (see section 51)
Load Setup Data.. Gtrl+L .
Soer mEle e L Save the setup data (see section 5.2)
H’ Save Measured & Setup Data.. Shift+s5 Load the setup data (see section 5_2)
H Load Measured & Setup Data.. Shift+L
Load the measured data and analysis results (see section 5.2)
& Print.. Cirl+P
M Print Setup.. Crl+R Save the measured data and analysis results (see section 5.2)
[& Print Preview Ot Print the analysis results (see section 5.3)
Print Option... Citrl+]
Exit = Set up printing (see section 5.3)

Print preview (see section 5.3)
Set print options (see section 5.3)

Exit the software (see page xvi)

Setup Menu (Settings before Loading Measured data)

Accumulation..  Shifteh Set the number of times to load the measured data (see section 1.1)
| Sl EHED Set communications (see section 1.2)
| ) Cle=r i GHirD Clear measured data and analysis results
View Menu (Display Settings of Analysis Results)
Histogram display (see section 3.1)
Matrix display (see section 4.1)
: Display the graph and a list of statistics of the histogram analysis
|l Histoeram Ctrl+H (see section 3 1)
[8 Matrix Cirl+M :
BE Histoeram and Table _ ShifteT Display only the graph of the histogram analysis (see section 3.1)
fa Histoeram Graph Shift+R Display all data of the histogram analysis (see section 3.1)
et (A el L /Sheet display of the average values of matrix analysis (see section 4.1)
[ statistics Averaee Shift+4f /Sheet display of the deviation of matrix analysis (see section 4.1)
ﬁ Statistics Deviation Shift+E - .
FE Statistics Jitter shiitvy -—— Sheet display of the jitter of matrix analysis (see section 4.1)
I Graph Shift+G Graph display of all data of matrix analysis (see section 4.1)
Bar Deviation Shift+E ~\ .
B Bar Jitter Shiftsl Graph display of the deviation of matrix analysis (see section 4.1)
oW Pulse Width Shift+P | Graph display of the jitter of matrix analysis (see section 4.1)
T i Uiyl EhifEL Display the pulse width data of matrix analysis (see section 4.1)
Zoam Gtrl+2 Display the A-to-B time interval data of the matrix analysis
Time Scale Crl+ll (see section 4.1)
Explanatary Notes GirieE Zoomed display of the graph of all data of matrix analysis (see section 4.1)
v Toal Bar Turn ON/OFF the time scale (see sections 3.1 and 4.1)
|T Trigger Bar

Turn ON/OFF the explanatory notes (see sections 3.1 and 4.1)
Turn ON/OFF the toolbar

Turn ON/OFF the trigger bar
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Functions of the Main Window Components and a List of Menus

Display Menu (Analysis Condition Settings, Etc.)

Analysis Mode..  Shifteh — Set the data polarity and modulation type (see section 2.1)
Wfincow.. Shift+if Set the window (see section 2.2)
Option Shift+0 - Set details of the analysis result display (see sections 3.1 and 4.1)
Camment.. Shift+G - Set the comment (see section 2.3)
Help Menu
Help  CrtF1 ——— Display the user's manual (PDF format)
@ About. (A} Display the software version, etc.
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Software Installation

System Requirements
PC
PC running Microsoft Windows 98 SE, Windows NT Workstation 4.0, Windows 2000
Professional, or Windows XP Professional with at least 64 MB (128 MB for Windows
2000 or XP) of memory.
Operating System
Microsoft Windows 98 SE, Windows NT Workstation 4.0, Windows 2000 Professional, or
Windows XP Professional.
CD-ROM Drive
The drive is used to install the software.
Free Hard Disk Space
40 MB or more
Display
SVGA (800 x 600 resolution) or better (1024 x 768 or better recommended) and capable
of displaying 256 or more colors.
Printer and Mouse
Printer and mouse compatible with the OS that you are using.
GPIB Board/PCMCIA-GPIB Card (only when connecting the TA320/TA520/TA720
and the PC using GP-IB)
GPIB board or PCMCIA-GPIB card by National Instruments along with the driver must be
installed in the PC.
Ethernet Port (only when connecting the TA720 and the PC via the Ethernet
network)
Port for connecting to the Ethernet network.
FD Drive (only when opening data saved to a floppy disk)
One 31/2" floppy disk drive capable of reading 1.44 MB floppy disks (MS-DOS
compatible).

Procedure

The following procedures are for installing the software on Windows 2000 Professional.

1. Start Windows.
Start windows with the user name set to Administrator. Otherwise, you will not be
able to install the software. The same is also true on a PC running Windows NT
Workstation 4.0 or Windows XP Professional.

When Auto Run Is Enabled

2. Insert the CD-ROM in the CD-ROM drive.
The installer automatically starts. Proceed to step 7.

When Auto Run Is Disabled

2. Open the Control Panel folder and double-click the Add/Remove Programs icon.

£ Control Panel =10l
he e ven Fomts oo w |
dmback - = v (2] | @isearch [yFolders (|05 O X >
Address [ Control Panel =] P |
o9
Accessibility  Add/Remove Administrative CSMW
Qptions Hardware g Tools
Date/Time Display  Folder Options Fonts Game x|
Installs and removes programs and | [ 4
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Software Installation

3. Click Add New Programs.
s addjemove programs

=1gix]

Currently installed programs: Sort by:[Mame -

Change/Remove

[} Adobe Acrobat 5.0 Size: 12.4MB
DAGLOGGER: Size 14.6MB
] Light Messursment Daka Mansgement Software Size 78BKB
3 Loss Size: 1.76MB
& Microsoft Tnkermet Explorer & Size 15.5MB
B Microsoft Office XF Frofsssions| Size 212M8
3 pC-cilin 2000 Size: 9.60MB
(80 Snaglt 6 Size 10.4MB
L3 wviewer Size: 736KB
=

4. Click CD or Floppy.
[ add/nemave programs

Add a program from CD-ROM or floppy disk.

To add a program from 5 CO-ROM or floppy disk, dlick CD or Floppy. €D or Fgppy

Add programs from Microsaft

; T sl riws Winclows Festures, device drivers, snd system updstes
a aver the Internet, dick windows Update. —IW'"dMS Cocate

=1gix]

Close

5. Insert the Software Installation CD-ROM in the CD-ROM drive and click Next.

Install Program From Floppy Disk or CD-ROM x|

Insert the product’s first installation floppy disk or CO-ROM,
and then click Mewt

< Back I Ne”thl Caricel
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Software Installation

6.

In the Open entry box, check that D:\Setup.exe (when drive D is the CD-ROM drive)

is displayed and click Finish.
The installer starts.
[Run Installation Program x|

IF this is the correct installation program, click Finish. To
start the autemalic search again, click Back, Ta manualy
search for the installation program, click Browss:

Oper:

D:ASetup exe Browse...

< Back I Finish 1 I Cancel

Click Next.

Welcome to the TA ISI Analysis 2 Setup Wizard

The installer will guide you through the steps required to install T4 151 Analpsis 2 on pour computer.

WARNING: This computer progiam s protected by copyiight law and intemalional treatics.
Unauthorized duplication or distribution of this pragram, or any pattion of i, may resultin severs civil
o ciiminal penalties, and wil be prosecuted to the masimum extent possible under the law.

Cancel | < Back |

After entering the destination, click Next.

The default installation destination is set to “C:\Program Files\Yokogawa\TA ISI

Analysis 2\ Change the destination as necessary.

{& TA ISI Analysis 2 ]

Select Installation Folder

The installer will install T4 |51 Analysis 2 to the following folder

Toinstallin this folder, click "Nest". To install to a different folder, enter it below or click "Browse""

Folder,

C\Frogram Files'VokogawahT A (5] Analysis 24 Browse
Disk Cast

Install TA |51 Analysis 2 for yourself, or for anpone wha uses this computer:

" Eveyone

@ Just me

Cancel < Back S R
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Software Installation

9. Click Next to start the installation.

JSIEIE
Confirm Installation '
==

The installer is ready to install T4 |51 Analysis 2 on your computer,

Click "Mext" to start the installation

Cancel | <Back

When the installation starts, the following dialog box appears.

{&% TA ISI Analysis 2 o]

Installing TA I1S| Analysis 2 -y
-

TA 15| Analysis 2 s being installsd.

Please wait.
<Back e,
10. Click Close to finish the installation.
=
Installation Complete ‘.'
‘?;‘_.Q

T4 151 Analysis 2 has been sucessfully installed.

Click "Close" to exit

Cancel <Back

Explanation
Installation Result
If the software is properly installed, a folder named TA ISI| Analysis 2 is automatically
created in the specified directory (C:\Program Files\Yokogawa\ by default) and TA ISI
Analysis 2 is registered in the program list. In addition, the TA ISI Analysis 2 icon is
created on the desktop.
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Starting and Exiting the Software

Procedure

Explanation

Starting the Software

Choose Start > Programs > TA ISI Analysis 2 as shown in the figure below or double-

click the TA ISI Analysis 2 icon on the desktop.

@ Accessoties L4
@ PC-cillin 2000 ’
Documents 4 Micrasoft WWard

Programs

Settings
@ DAGLOGGER

@ Search 4 @ Oracle - OraHomes1
@ L¥ Operation Support System (LXOSS)

@ e @ ScreenPrint Gold 3.5
- gﬁ Run... E TAIS

§ . Shut Down. .
I astart

Exiting the Software.
From the File menu, choose Exit.

* v v v

=]
w1l

J (=] Contral Panel | [E515naglt

ol Interferenc

File Sstup Wiew Display Hslp

= Open Ctrl+0
%‘ QOpen From Communication Crl+G
Comm / Data File List, Ctrl+L
Save Statistics (Triceered T). Girl+T
Save Statistios (Al Trieeered T Ctrlsfy
Save Matrix Statistics. Cirl+M
Save Setup Data, Cirl+&
Load Setup Data.. Ctrl+L
E’ Save Measured & Setup Data Shift+3
ﬂ Load Measured & Setup Data.. Shift+L
& Print Girl+P
O Frint Setup.. Ctr+R
[&, Frint Preview Ctrby
Print Option... Cirl+l

ETE—

When you start the software, the main window shown below opens.

a101x|
=3Py I s 6 W m|
TO90Er [ space [ 2 mane | =1 space | E T =l )
e — —
= E Phase e
TATZD FulseWidth,CHA Both
Data to Data All Space Statistics
Diaia fo data Selecied Space Stallsilcs
Dt tn Dsks & & Sebectad Spaca Histogram Lot
oo Feight
Cantar
- Aorige

Note

Acrobat Distiler 5.0 Icon on the desktop

» When you exit the software, the setup data is automatically saved. Therefore, when you start

the software again, the main window is displayed using the previous settings not the initial

settings.
* You cannot run multiple instances of the software.
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Chapter 1 Loading of Measured Data

1.1 Selecting the Number of Times to Load the
Measured Data

Procedure

Explanation

1. From the Setup menu, choose Accumulation to open the Accumulation Setting

dialog box.

2 Optical ter=Sym
File | Setup Miew Display Help

= Accumulation.. Shift+a

Trige Communication Shift+C |
Ch.A
ChE &P Clear Data Citrl+D

2. From the Data Accumulation Number list box, select the number of times to load

the data.
You can also enter a value directly in the box.

Accumulation Setting Dial

3. Click OK.
To cancel the setting, click Cancel.

Selecting the Number of Times to Load the Measured Data

Set the value in the range of 1 to 64. However, if the number of accumulated points of
measured data to be loaded exceeds 2 Mpoints, the exceeded portion of the data is not
loaded even if the specified number of times has not been reached.

Display of the Accumulation Number and the Number of Data Points
As shown in the figure below, the values are shown at the top section of the analysis
result display area when you start loading the measured data.

@ Optical Digk Ir wmbol Interference Ar
File Setup Miew Display Help

EET T EIRE N E T
Trigger [~ space |4l 2| % omank T =l
chA —
ChB r r r r

IFA?ED Pulsewidth&Timelnterval,ChA ChB Both—>Rise
10000 Sample Data Accumulation 1/5 —— Spec|f|ed accumulation number

Number of data points Number of times already loaded
already loaded

Note

« If the data is loaded more than the specified number of times, the accumulated data is cleared,
and the accumulation starts over. For example, if the number of times to load the data is set to
3 and the data is loaded 5 times, only the 4th and 5th data set will remain. If multiple files are
loaded simultaneously, however, the loading stops upon reaching the specified number.

» The data can be accumulated even if the method of loading the measured data is different as
long as the model and measurement conditions are the same. For example, if the number of
accumulations remain after loading the measured data directly from the TA via communications,
you can continue to load the measured data by opening a measurement data file.

IM 704223-61E
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1.2 Setting Up Communications (Settings When
Loading Measured Data via the Communication
Interface)

Procedure

Before using the following procedure, the applicable TA and PC must be connected and

communication must be possible.

1. From the Setup menu, choose Communication to open the Communication dialog
box.

[ Cptical Digk Iiter-Symbal Interference

File | Setup Miew Display Help

= Hocumulation... Shift+#&

Communication Shift+C |

ChE &P Clear Data Shift+D

When Communicating via the GP-IB Interface

2. Click the GPIB option button under Device.

3. Inthe Address entry box, enter the GP-IB address of the applicable TA.
When you click Search TA Address, the address of the TA320, TA520, or TA720
connected via the GP-IB interface is searched, and the found address appears in the
Address entry box.

Communication Dialog ll

— Device —GPIB

Address (1 to 300 |2 vl

Search TA address |

— Ethernet

" Ethernet IF address 0 0 255 255

Uzer name Ianony mous
Pazsword I

¥ | atiorymaus

oK I Cancel

4. Click OK.
To cancel the setting, click Cancel.

When Communicating via the Ethernet Network

2. Click the Ethernet option button under Device.

3. Inthe IP Address, User Name, and Password entry boxes, enter the IP address,
user name, and password, respectively.
The default user name is anonymous. To specify a user name other than
anonymous, click the Anonymous check box to unselect it.

1-2
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1.2 Setting Up Communications (Settings When Loading Measured Data via the Communication Interface)

Explanation

Communication Dialog ll

— Device —GPIB

" GPIB Address (1 to 300 |2 vl

Search TA address |

— Ethernet

IP addrez= 0 0 255 28R

Uzer name Ianony mous
Pazsword I

[¥ anonymous

oK I Cancel

4. Click OK.
When you click OK, communication with the TA starts.
If an error message such as “Device initialize error.” appears, communication with
the TA is not possible. In such case, check the connection and communication
settings.
To cancel the setting, click Cancel.

Setting the GP-IB Address
Set the GP-IB address in the range of 1 to 30 according to the address specified on the
applicable TA. The default value is 1.

Note
« If the entered address and the address of the connected TA320, TA520, or TA720 do not match,
measured data cannot be loaded.
« Address 0 is reserved for the GPIB board or GPIB card of the PC.

Searching the GP-IB Address

« The address does not change if the TA320, TA520, or TA720 is not connected.

« If there are multiple TA320s, TA520s, or TA720s that are connected, the smallest
address is set in the Address box.

Setting the IP Address
Set the IP address that was assigned to the TA720 that you are connecting to. The
default value is 10.0.255.255.

Setting the User Name and Password
Set the user name and password that were assigned to the TA720 that you are
connecting to. The default user name is anonymous.

IM 704223-61E
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1.3 Loading Measured Data

Procedure

If you wish to load and analyze a new set of measured data when measured data is
already loaded, choose Clear Data from the Setup menu to clear the existing measured
data and analysis results.

When Loading the Data by Opening Files

1. From the File menu, choose Open to open the Open dialog box.

|Ie . Setup Vlew

%‘ Open Fram Communication... Citrl+G

|Splay Help

Camm / Data File List.. Citrl+L

2. Specify Look in and select the file name from the file list or enter the name of the file
you wish to open in the File name text box.
You can select multiple files. In this case, the data is loaded in the order in which the
file was selected.

j pwpw_101a.wf
j pepwl01 vk
Q prpw 102 vk
Q puiti_abbp_101a.wef
Q puwiti_apbp_101a.wf
] ki1 01w

] ki 102, v

Q pkis 102w

File name: Ipw‘l 02w

Open I
Cancel |

Lef e

N Files of type: W/ AVE file (%]

3. Click Open to load the measured data.
To cancel the data load operation, click Cancel.

When Loading the Data via the Communication Interface
Before using the following procedure, connection with the applicable TA, communication
settings (see page 1-2), and measurement conditions on the TA must be completed.
1. From the File menu, choose Open From Communication to open the Open From
Communication dialog box.
¥ Cptical Digk nbol Interference &
’ﬁ Setup  Miew Display Help
= Open.. Citrl+0
ﬂ Open From Sommunication.. Cirl+G

Camm / Data File List.. Citrl+L
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1.3 Loading Measured Data

Explanation

2. Select the Recall check box and select from the Load# list box the memory number in
which the setup data for loading the measured data from the applicable TA is stored.
If you wish to use the current settings of the applicable TA, clear the Recall check box.
x|

Open From Communication Dialog

Accumulation maode
& Auto

 Marusl

3. Select the mode for loading the measured data using the Accumulation Mode
option button.
To load the measured data once, select Manual.

4. Click OK to load the measured data.
When you click OK, measurement automatically starts on the TA.
If communication with the applicable TA is not possible, an error message such as
“Device initialize error.” appears. In such case, check the connection and
communication settings.
To cancel the data load operation, click Cancel.

Applicable Files for Loading Measured Data

The applicable measured data that can be loaded is data that has been measured and
saved under the following conditions on the TA. The extension of the measured data file
is .wvf. To load the measured data, the header file that is created when the measured
data is saved (.hdr extension) is also needed.

Model Sampling Mode Measurement Function
TA320  Time stamp mode Pulse width (both polarities) measurement
TA520  Time stamp mode Pulse width (both polarities) measurement

TA720 Inter-symbol interference  Pulse width (both polarities) measurement, pulse width
analysis mode A—pulse width B measurement, or pulse width A—A-to-
B time interval measurement

Note
¢ To load measured data of the TA720, the TA720 ROM version must be 1.02 or later. You
can check the ROM version of the TA720 in the Version Information dialog box that
appears by selecting Utility > Version on the TA720.
* In the case of the TA520, the TA520’s built-in hard disk (option) can be accessed from the PC by
connecting the PC to the TA520’s SCSI (option). For a description of the connection procedure
and other information, see chapter 11 in the TA520 User’s Manual (IM704310-01E).

Selecting the Setup Data When Loading Measured Data via the Communication
Interface

Select the current setting of the applicable TA or select the memory number
corresponding to the setup data stored in the internal memory in the range of 0 to 31 (0
to 9 when loading measured data from the TA320 or TA520). The measurement
conditions of the setup data to be loaded must match the measurement conditions in
“Applicable Files for Loading Measured Data” described above. The settings of the TA
change to the stored settings of the selected memory number.

Selecting the Data Load Mode

Select the load method of the measured data from the following:

» Auto:  The TA automatically repeats the measurement for the number of times
specified in section 1.1, and the software loads the measured data.

« Manual: The TA make one measurement, and the software loads the measured data.

IM 704223-61E
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1.4 Displaying a List of Files of the Loaded
Measured Data

Procedure
1. From the File menu, choose Comm/Data File List to open the Communication/Data

File List dialog box.
[ Cptical Digk It

File Setup Miew Display Help

= Open..
%‘ Open Fram Communication... Citrl+G

Carl+0

Camm / Data File List.. Cirl+L

Cawa Thatictine (Trizaavad Th Ml T

The following dialog box opens.

Communication / Data File List Dialog

1. CADocuments and Settings\AdministratorDesktopitestdatatpwpw 02, wf
2: CADocuments and Settingst\Administrator\Desktopitestdataipwpw! 22 waf

2. Click OK to close the dialog box.

Explanation
Information That Are Listed
The path information or file name of all the loaded measured data is listed in the order of

loading.

The data loaded from the file is displayed in the format “Load number: Drive
letter\Directory path\File name.” If the data is loaded via the GP-IB interface, the data is
displayed as “Load number: GPIB.” If the data is loaded via the Ethernet network, it is
displayed as “Load number: ETHERNET”

Display examples

1:C\TA_Data\Dvd001.wvf

2:C\TA_Data\Dvd002.wvf

3:GPIB

IM 704223-61E
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Chapter 2 Setting Data Analysis Conditions and Setting Comments

2.1 Setting the Data Polarity and Modulation Type

Procedure

Explanation

From the Display menu, choose Analysis Mode to open the Analysis Mode dialog
box.

¥ Cptical Digk Inter-Symbal Interference Analys

File Setup Miew | Display Help

ST

| Ahalys ode. k Shift+ |8
Tigger [ gps B Windon. Shift
Ccd Option Shift+D
ChB

rm Comment.. Shift+C

Select the polarity of the space/mark data using the Polarity option button.
dode Dialog 1'

—Polarity

o Mark - Space

r—Modulation
 BAT(EFM; 3T-=11T)
% B-16( EFM-Plus: 3T-=11T,14T )
1.7 27-26T)
 Marusl

—Select T (Manual)

it WMst WMar 13T
Mz Fer M1 5
Mar M W
Va4t WMear Wizr

OK I Cancel |

Select the pulse width modulation type of the data using the Modulation option
button.

If you select Manual, select the T symbol to be analyzed using the Select T (Manual)
check boxes.

Click OK.

To cancel the setting, click Cancel.

Selecting the Data Polarity
Select the relationship between the pulse polarity and Mark/Space from the following.

* +:Space —: Mark
Sets the pulse high level (+) to Space and low level (-) to Mark.
e +:Mark —: Space

Sets the pulse high level (+) to Mark and low level (-) to Space.

Selecting the Pulse Width Modulation Type
Select how the loaded measured data is to be handled in terms of the modulation signal.
* 8-17(EFM: 3T->11T)
Analyze the data in the range of 3T to 11T.
+ 8-16(EFM-Plus: 3T->14T)
Analyze the data in the range of 3T to 11T+14T.
« 1-7(2T->8T)
Analyze the data in the range of 2T to 8T.
* Manual
Select the data to be analyzed from 1T to 14T.

IM 704223-61E
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2.2 Setting the Window and Arbitrary Setting the
Center Value of Deviation

Procedure
1. From the Display menu, choose Window to open the Window Setting dialog box.

| & o G € Analbsis Mode.  ShifteM
Trigger Sps Windavs |

Chly Option Shift+0
chB

IW_ : Qolmment... _ ‘Shift+0

2. Inthe Window Setting dialog box, set the window size and the window values.
The following figure shows a display example when Modulation of the Analysis Mode
dialog box is set to Manual and all the data from 1T to 14T are analyzed.
Determine the reference T and set the values

Window Setting Dialog x|
—Space YWindow —Mark YWincdow Size Adjustment
A = { Center,Span  Leit Right l—— Set the method of setting
= Nz Space Update =| NZ  park Update . .
| | Easy T Setting the window size
Base INone j Center |3? ns Base INone j Center 13? ns Media
D
Center (ns Span (Ns Center (ns Span (Ns
(nz) Span (n2) (nz) Span (n2) & DVD f User
1T |37 - |85 i - [18s
a7 * ns
- |?4 + [185 ot [7e s [1as | Set the T values at xN speed
|27 = MHz
aT |11 - |1as aT [ 111 - [18s
4T|143 +- |18.5 4T|148 +- |18.5
1% | 2% | ax | ex | ax
5T [185 - |1as 5T [ 185 - [18s
125 | 18 | 2o | 243 | B2
BT |222 - |1as BT [ 222 - [18s
4 | ag
7T | 259 - |1as 7T [ 259 - [18s
| | 1K
8T | 295 - |1as 8T [ 298 - [18s Uam
a7 [333 - |1as o1 [333 - [18s Wr——
ot [370 - |1as ot [ 370 - [18s T=|--- =
1T [ 407 - |1as 17 [ 407 - [18s Copy Estimated Tto T | Set the T values estimated
a1 |444 +- |18.5 a1 |444 +- |18.5 from the data
ar [41 + [185 ar [4s1 + 185 Devistion Option... :I—— When arbitrarily setting the
o o - - center values for
gl =16 i L gl 51 "~ 1e5 : ; Cancel | determining the deviation

Enter values for each window

The following four methods are available in setting the window values.
¢ Entering Values Directly in Space Window and Mark Window
Enter values directly in the 1T to 14T entry boxes.

* Determining the Reference T and Setting the Values
1.Enter constant T in the Space or Mark T text box.
2.From the Base list, select the window T to be the reference.
If you do not select , enter the center value of the window in the Center text box.
3.Click Space Update or Mark Update.
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2.2 Setting the Window and Arbitrary Setting the Center Value of Deviation

Explanation

e Collectively Setting the Values by Specifying the xN Speed
1.Select the CD or DVD/User option button under Media under Easy T Setting.
If you select DVD/User, set the clock in units of ns or MHz.
2.Click the desired xN speed button or enter an arbitrary xN speed value in the
USER text box and click the USER button.

¢ Using the T Value That Is Estimated from the Data to Set the Values
Click Copy Estimated T to T under Estimated T.
The window is set based on the T value estimated from the average of the data.
However, if Modulation in the Analysis Mode dialog box was set to Manual, the
Copy Estimated T to T button is disabled.

Arbitrarily Setting the Center Value of Deviation

When determining the center value of deviation arbitrarily, set the center value using the

following procedure. If you are not setting the center value, proceed to step 8.
4. Click Deviation Option to open the Deviation Option dialog box.
5. Select the Use Deviation Option check box.

6. Enter the center value of each window.
If you had saved the center values specified in the past, you can click Load to load
the center values that had been saved.

7. Click OK.

To save the specified center values, click Save to open the Save As dialog box and

save the values.

Deviation Option Dialog

Load | Save
—Space —Mark

1T l?ﬁ"— 1T |3}'—ns
a1 |?4— a1 |?4—ns
4T |148 ns 4T |148 ns
5T |185 ns 5T |185 ns
BT | 222 ns BT |222 ns
T |25£-l— ns T |2SEI— ns
8T |298— nz 8T |298— nz
aT |333— ns aT |333— ns
107 |3?'U— ns 107 |3?'U— ns
1T IW— S 1T IW— S
12T |444— ns 12T |444— ns
137 IW— ns 137 IW— ns
14T |518— ns 14T |518— ns
OK I Cancel |

Confirming the Settings in the Window Setting Dialog Box

8. Click OK.

To cancel the setting, click Cancel.

Setting the Method of Setting the Window Size
To set each window using center values and span, select Center, Span. To set the
windows using left and right values, select Left, Right.

IM 704223-61E
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2.2 Setting the Window and Arbitrary Setting the Center Value of Deviation

Setting the Window

Set the Center and Span values or Left and Right values of windows 1T to 14T according

to the following conditions.

+ Set the values so the start point is less than the end point for each window.

+ Set the values so that the end point of the previous window is less than or equal to the
start point of the next window.

+ Selectable range: 1 ns to 5800 ns (0.0001 ns steps)

ConstantT

T indicates the sampling clock cycle of the disk or drive under analysis and becomes a
reference in determining the start/end points and window widths (size of the window) of
each window. The selectable range is 1 ns to 400 ns (0.0001 ns steps).

Base/Center
Select the reference window (Base) from 1T to 14T and set its center value. The
selectable range of the center value is 1 ns to 5800 ns (0.0001 ns steps).

Selecting the xN Speed
The selectable range varies depending on whether CD or DVD is selected as follows:
CD: The clock cycle (T) is fixed to 231.385 ns.
The following xN speed values can be selected. If you select USER, the
value can be set arbitrarily in the range of 1 to 50 (0.1 steps).
1x, 2%, 4x, 6x, 8x, 10x, 12x, 16x, 20x, 24x, 32x, 40x, 48x, and USER
DVD/User: The clock cycle (T) can be set arbitrarily in the range of 1 ns to 400 ns
(0.0001 ns steps). The clock cycle can also be set in terms of the frequency
(MHz).
The following xN speed values can be selected. If you select USER, the
value can be set arbitrarily in the range of 1 to 50 (0.1 steps).
1%, 2x, 4x, 8x, and USER

Arbitrarily Setting the Center Value of Deviation

Specify this value when setting the center values used to determine the deviation to
values other than the center values specified in the Window Setting dialog box. The
specified center values are valid when the Use Deviation Option check box is selected.
The specified center values can be saved and loaded. The extension of the file
containing the center values is .dev.

Setting the Window Outside the Window Setting Dialog Box

During histogram display, the Center/Span or Left/Right values of each window can be
changed using the mouse. Placing the mouse over the Left/Right or Center/Span line
causes a hand mark to appear. By dragging the mark left and right, the Left/Right or
Center/Span values can be changed. The items whose Linkage check box is selected
under the Histogram tab that appears when Option is chosen from the Display menu are
changed in link. For the setup procedure of Linkage, see page 3-2.

Average (broken red line)
Center of the window (broken green line)

Indicates the value being moved,
T symbol, and position (time)

End point of the window (broken yellow line)
Start point of the window (broken yellow line)

2-4
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2.2 Setting the Window and Arbitrary Setting the Center Value of Deviation

Note
If you wish to restore the previous window settings after changing the settings and pressing the
OK button, you must open the window setting dialog box again and reenter the appropriate
values. If there is a possibility of setting the values back to the previous values, it is recom-
mended that you save the setup data before changing the values. For the procedure of saving the
setup data, see section 5.2, “Saving and Loading Setup Data and Measured Data.”

IM 704223-61E
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2.3 Setting Comments

Procedure

Explanation

1. From the Display menu, choose Comment to open the Comment dialog box.

Display Help

| @ o @ & Analysis Mode.  ShiftsM |

| Trigger  gpe B Windon. Shift+f
Chly Optian Shift+0
chB

rm Comment.. Shift+C

—~ . s . r

2. Enter a comment in the Comment text box.

Comment Dialog

Comment : JDVD Tast ABC

0K I Cancel

3. Click OK.
To cancel the setting, click Cancel.

Clearing Comments
Open the Comment dialog box and clear the text in the Comment text box and click OK.

Number of Characters That Can Be Entered for the Comment
The number of characters that can be entered is up to 50 alphanumeric characters.

Displaying and Printing Comments
The comments are displayed on the screen as follows.
Comment

E’g’ DOptical Disk Inter-Symbol Interference Analysis Software

=10l x|

File Setup VYiew Display Help

FEMNES ORI E ] N EE 7 (B2

THgger [~ gpace |4l 2| [ wanc fan | space |4 2| wanc el
Cha

j Calculate

- r " * —

Phase| 0.00 —ing
A720 PulseWidth,ChA Both( DVD ABC
10000 Sample Data Accumulation
Data to Data All Space Statistics

[stat~_ 7] 371 [ 417 [ 51 [ & [ 77 [ 87 [ o1 [ 10T [ MT [ 14T |
[ Avelnst | 100582 [ 148756 | 182,941 | 218548 [ 257.653 | 296369 [ 333715 | 368.984 | 406840 |

517.404 |
When the analysis results are printed, the comments are printed as follows.
Comment
DwD ABC

TAF20 Pulseiidth, Cha Bath

10000 Sample Data Accumulation 171

Trigger Condition

Polarity Space Mark Space Mark

Trigger All ) )

Target Data to Data Average M\gtﬁfgflnter-)é\ﬁxnlhsol Interference

o T T A T T s T T 3 T A T o T o T 0 10 ’ L |
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Chapter 3 Data Analysis on Histograms

3.1 Setting the Display Format of Analysis Results

Procedure
Selecting the Histogram Display
1. From the View menu, choose Histogram.

e Setup | Wiew Display Help

e

Trigger

Selecting Simultaneous Display of the Histogram and the List of Statistics or Only

the Histogram Display

2. To display the histogram and the List of Statistics simultaneously, choose Histogram
& Table from the View menu. To display only the histogram, choose Histogram

Graph.
[ Cptical Digk It smbol Interference An. ofty = Optical Disk Int mbal Interference fn
File Setup | Wiew Display Help Flle Setup | Wiew Display Help
= %‘ |i Histoeram Ctr+bH g = %‘ |i Histoeram Cirl+H
_Tngger [ Matrix Ctrlem L _Tngger [8 Matrix Ctrl+M
G =5l Histosram & Table N Shift+T eha [B5 Histosram & Table  ShiftsT
{8 Histoeram Graph Shift+R ™ h :
[TA720 Puls — [TA720 Puls —

Selecting Only the Extracted Data Display or Extracted Data and All Data Display
3. From the View menu, choose All Graph.
When the All button to the left of All Graph appears depressed, extracted data and
all data display is enabled. If you select All Graph in this condition, only the
extracted data is displayed.

= er-Symbol Interference An
File Setup | Wiew Display Help

°°'"' |i Histogram Ctrl+H
_Trlgger [# Matrix L L
G [B5 Histogram & Table  Shift+T
| e Histogram Graph Shift+R
4720 Puls

100003aMw

Showing or Hiding the Time Scale Display of the X-Axis and the Graph Explanatory

Notes

4. To show the time scale on the X-axis, choose Time Scale from the View menu. To
show the graph explanatory notes, choose Explanatory Notes.

sk Inter-Symbal Interference An s Softy = & 0
File Setup | Wiew Display Help File  Setup | Wiew Display Help
°°'"' |i Histogram Cirl+H °°'"' |i Histogram Ctrl+H
_Tngger [ Matrix GtrbeM I _Tngger [8 Matrix Ctrl+M
G [B5 Histogram & Table  Shift+T G [B5 Histogram & Table  Shift+T
las Histogram Graph Shift+R las Histogram Graph Shift+R
TAT20 Fuls - TAT20 Fuls -
10000 Saw All Graph Shift+H 10000 Saw All Graph Shift+H
oo ﬁ Statistice Average Shift+i t oo ﬁ Statistics fverage Shift+h
ﬁ Statistice Deviation Shift+E ﬁ Statistice Deviation Shift+E
ﬁ Statistice Jitter Shiftt.] Statistice Jitter Shiftt.]
[ Graph Shift+G Graph Shift+G
Bar Deviation ShifttE = Bar Deviation ShifttE
Ear Jitter Shift+l ™ Bar Jitter Shift+l
iy Pulse Width Shift+F iy Pulse Width Shift+F
T Time Interval Shift+L T Time Interval Shift+L
1o |T ZOom Cirl+d |T ZOom Cirl+d
e |T Time Scale Crl+U
Explanatory Notes Ctrl+E Citrl+E
M-
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3.1 Setting the Display Format of Analysis Results

Items displayed

in the list of
statistics

Jitter unit

Color of each
display item

Explanation

Selecting the Items to Be Displayed in the List of Statistics, Jitter Unit, Linked
Items When Window Is Changed, Displayed Item Colors, Y-Axis Scale, and Line
Plot of Deviation and Jitter
5. From the Display menu, choose Option.
¥ Cptical D ol Interf e A ftiare
File Setup Miew | Display Help
= %‘ H H’ é fnalysiz Mode... Shift+M |,
| Trigger  gpe B Windon. Shift+f
ChA —

Comment.. Shift+C

[TA720 Pulselwidtt

6. Inthe Option dialog box, select the Histogram tab.
7. Set the items in the dialog box that appears.
Histogram tab

x|
Histogram |n-1atrix | Matrix-Gragh | Matrix-Dev. | Matrix-ditter | Phase |
— Statistics for table Linkage —
V¥ &verage I Certer
[V Devistion I Span Check boxes for linked items
v diter  Let when changing the Center,
¥ hlum. R Span, Left, or Right value of
- 2 the window
Jitter unit Scale —|
*‘7—{5‘ Time (=) Percert [ % )| * Log Linear Vertical axis scale
—Caolar Line plot
All histogram - colar_. {* Mone
Selected histoaram - C— " Devation Turn ONIO_Fl-j the Iir_1_e plot
Bl O Jitter of the deviation or jitter
Line pict l:l Colar ...
Cancel |

8. Click OK.
To cancel the setting, click Cancel.

Selecting Simultaneous Display of the Histogram and the List of Statistics
(Histogram & Table) or Only the Histogram Display (Histogram Graph)

Select whether to display the histogram and the list of statistics simultaneously or only
the histogram.

+ Display example when the histogram and the list of statistics are displayed

simultaneously
Data fo data All Space Sfatistics

SII;T‘\ T 3T 4T AT AT T 8T a7 10T 11T
Ave.[ns] 109.562 148918 182495 218755 2574149 296378 333631 370,092 406347
Dev.[ns] -1.438 0918 -2.404 -3244 -1.481 0378 0631 0032 -0653
Jitter[ns] 5.292 4.030 3956 3920 4015 3713 34642 3883 3081

MNum 1576 1212 820 591 354 215 137 71 q
BData fo data Selecfed Space Stafistics

Stat~—. T T 4T a7 BT T a7 aT 10T 11T
Awe.[ns] 111.420 140,870 183078 210186 2584505 287.212 334378 371.098 406.587
Dev[ns] 0.420 1.879 -1.922 -2.814 -0.435 1.212 1.378 1.088 -0.413
Jitter[ns] 5.224 4.109 4.078 4127 42117 3363 4.342 3.453 3.588

Murm 573 401 229 178 119 5 4 21 2

Data to Data All & Selected Space Histogram

oo

Note
When displaying the statistics of both the extracted data and all data, the histogram may not be

displayed depending on the setting of the data extraction conditions and the display resolution
that you are using.
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3.1 Setting the Display Format of Analysis Results

» Display example when only the histogram is displayed

Data to Data All & Selected Space Histogram

oo,

Selecting Only the Extracted Data Display or Extracted Data and All Data Display
(All Graph)

Select whether to display only the data that matched the data extraction conditions or
also display all the data.

» Display example when only the extracted data is displayed
Data fo data Selected Mark Statistics

o
o
—
o
>
5
o
<
@,
®
o
S
<
@
—
)
Q
=
)
3
o

Sté?‘-\ T 3T T T BT T 8T a1 10T 1T
Ave.[ns] 2147 142.395 185226 222168 265.298 303.829 340778 376.748 415.080
Dev.[ns] 1.147 4.3495 0.226 0.163 6.298 7.929 7778 B.748 8.080
Jitter[ns] 4.637 3.854 4.123 4.143 4.162 3.663 3.842 3.990 2.194

MNum 579 425 217 170 40 fi2 36 22 5

Data to Data Selected Mark Histogram

« Display example of extracted data and all data
Data to data All Mark Statistics

SII;T‘\ T 3T T 5T BT T 8T a1 10T 1T
Ave.[ns] 10735 140911 184 362 221252 263525 301.8497 339.608 375.569 3518
Dev.[ns] -0.265 2811 -0.738 -0.748 4.525 5.997 B.606 5.569 B.516
Jitter[ns] 4.403 3.787 3.995 4.044 4.236 3.950 3.635 4.273 3.778

MNum 1620 1218 810 563 352 221 102 g1 16
Data fo data Selecfed Mark Statistics

Stat~—. T T 4T T 6T T aT aT 10T T
Awe.[ns] 112.147 152.395 185.226 222.168 265.298 303.929 340.779 376.748 415.080
Dev[ns] 1.147 4.395 0.226 0.169 6.293 7.929 7.779 6.743 8.020
Jitter[ns] 4.637 3.854 4.123 4.143 4.162 3.663 3.842 3.940 2.194

Murm 578 415 217 170 a0 2 36 22 5

Data to Data All & Selected Mark Histoaram

3T 4T 5T 6T T aT aT 10T HT

Time Scale Display of the X-Axis
Select whether to display the time scale on the X-axis as shown in the following figure.

Data to Data All & Selected Mark Histogram

aT 41 aT o1 o o7 or o7 T

oo,

Time scale
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3.1 Setting the Display Format of Analysis Results

Graph Explanatory Notes
Select whether to display the explanatory notes of the graph as shown in the following
figure.

Data to Data All & Selected Mark Histogram All

Explanatory notes

Selecting the Items to Be Displayed in the List of Statistics (Statistics for Table)
You can display the average value (Ave.), the deviation (Dev.), jitter, and the number of

data points (Num). Clear the check box for statistics you do not wish to display.
Data to data Al Mark Statistics

Btﬁf‘-\ T 3T 4T T BT T 8T aT 10T 1T
Ave.[ns] 10735 140911 184 362 221252 263525 301.8497 339.608 375.569 3518
Dev.[ns] -0.265 2811 -0.738 -0.748 4.525 5.997 B.606 5.569 B.516
Jitter[ns] 4.403 3.787 3.995 4.044 4.236 3.950 3.635 4.273 3.778

MNum 1620 1218 810 563 352 221 102 g1 16

Selecting the Jitter Unit

Select time (ns) or percent (%).

» Time(ns): o (standard deviation)
» Percent(%): Jitter (ns)/Tx100

Displaying the Line Plot of Statistics (Line Plot)

A line plot of the statistics (deviation or jitter) can be displayed superimposed on the
histogram. To display the graph, choose Deviation or Jitter.

« Example when the line plot of deviation is displayed

Data to Data All & Selected Space Histogram —All
oo " 40 —Selected
v . . H g | | | g ' 1 Dexlns]
Left

Right
Center
------- Average
T 4T 5T 6T T aT aT 10T 11T 14T
» Example when the line plot of jitter is displayed
Data to Data All & Selected Space Histogram —All
oo ' ' ’ ' ' ' ' ' ’ " 40 —Selected
: | | | : Vo ditterins]
Left
Right

Center

3T 4T a7 6T T aT 9T 10T 1T 14T

Linked Items When Windows Is Changed (Linkage)

The Center, Span, Left, and Right values of the window can be changed on the
histogram display (see page 2-4). To link the change in each value, select the Linkage
check box for the items you wish to link.

Changing the Histogram Display Color

You can change the display color of the histogram.

+ All histogram: The display color of the histograms of all Mark data or all Space
data. The default value is blue.

+ Selected histogram: The display color of the histogram of data that match the data
extraction condition. The default value is red.

+ Line plot: The display color of the line plot of the deviation or jitter. The
default setting is orange.

The color is set in the Color dialog box. You can use the 48 basic colors as well as

original colors that you create.

3-4
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3.1 Setting the Display Format of Analysis Results

Selecting the Y-Axis Scale
You can select whether to use a log scale or a linear scale for the histogram’s Y-axis.

» Display example of a log scale
100,

a7 aT aT aT BT

» Display example of a linear scale
Bo_

HO_ .

0.

o
o
—
)
>
5
D
<
@,
®
o
5
X
@
—
o
Q
Q
o
3
o
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3.2 Setting

the Data Extraction Conditions and

Executing the Analysis

Procedure

Set the data extraction conditions using the trigger bar shown below.
When the measured data of pulse width A—A-to-B time interval measurement of the
TA720 is loaded, phase adjustment is possible using the Phase text box.

Select the Mark/Space to be used as a trigger

Select the T symbol of the Mark/Space to be used as a trigger i
Execute the analysis

I
CENESOR I AR & A AL - ==
T;Lgi*?f ™ space [ =l mark Al =] ® apace Jai =] mane A = @
ChB I i Im w1 I| |? II_ |? W2 II Phasel D_DID j ns
| | | | I | |
Adjust the phase
Set the extracted data
Note
The trigger bar can be displayed on a separate window. Click near the border of the toolbar and
the trigger bar and drag to separate the trigger bar from the toolbar. To return to the original
condition, drag the trigger bar on top of the toolbar.
2. Click Calculate to perform the analysis.
The Calculate button becomes available only when a possible data extraction
condition is specified.
Changing the Phase Adjustment Resolution
1. From the Display menu, choose Option.
[ Cptical Digk It nbol Interference Anal;
File Setup Miew | Display Help
= %‘ H H’ é fnalysiz Mode... Shift+M |,
| Trigger  gpe B Windon. Shift+f
Ch A Optian Shift+0
I’m Comment.. Shift+C
2. In the Option dialog box, select the Phase tab. In the dialog box that appears, set
Phase adjustment resolution to 0.01ns, 0.1ns, or 1ns.
I
Histogram | Matrix | Matrix-Graph | Matrix-Dev. | Matric-Jiter Fhase |
Phasze adjustment resolution ———————————
’7 {* 0.01n= " 0ins " 1ns
Explanation

Data Extraction Conditions
The following data extractions are possible.

Use a Space or Mark as a trigger to extract the data around it

Example when using the Mark of all Ts as a trigger to extract the pulse width data of
the subsequent Space

Trigger [ Space |27 1 ¥ mark IA” 'l [ Space |4 T T Mark |2 -
cha —— —
ChE ] = r r d r Ph
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3.2 Setting the Data Extraction Conditions and Executing the Analysis

Example when using the Space of all Ts as a trigger to extract the A-to-B time interval
from the edge on each end on the PW—TI measurement data of the TA720

Trigger [ Space |27 1T mark IA” 'l ¥ Space |Al T Mark |2 -
cha —— —
ChB r - - 2 L IV uz Fh

Example when using the Space of 5T as a trigger to extract the A-to-B time interval from
the front edge and the preceding edge on the PW—TI| measurement data of the TA720

Trigger I |3T 'l I~ Mark |4T 'l ¥ Space |5T T mark Al K
cha —— —
r r ] Fh

chB ™ X ¥ X2 i1

» Use a Mark followed by a Space or a Space followed by a Mark as a trigger to extract
data around it
Example when using the Space of all Ts after the 4T Mark as a trigger to extract the
pulse width data of the Space before them

Trigger [ Space |27 1 ¥ mark |4T 'l ¥ Space |Al T Mark |2 -
cha —— —
¥ r o Fh

che r r

» Use a Space and a Space or a Mark and a Mark as a trigger to extract the data
between two Spaces or two Marks
Example when using the Space of 2T and the Space of 4T as a trigger to extract the
pulse width data of the Mark in between the two Spaces

Trigger ¥ Space |2T T mark |4T 'l ¥ Space |47 | T wark Al -
cha — —
r g r r Ph

che r r

Example when using the Space of 3T and the Space of 5T as a trigger to extract the
A-to-B time interval from the edge on each end of the Mark in between the two Spaces
on the PW—TI measurement data of the TA720

Trigger ¥ Space |3T T mark |4T 'l ¥ Space |5T | T wark Al -
cha —— —
r r ] Fh

che v I

T Symbol of the Space or Mark to Be Used as a Trigger
You can select from the following.
All, 1T, 2T, 3T, 4T, 5T, 6T, 7T, 8T, 9T, 10T, 11T, 14T, Min.T-1T, Min.T-2T, Min.T-3T, Min.T-
4T, Min.T-5T, Min.T-6T, Min.T-7T, Min.T-8T, Min.T-9T, Min.T-10T, Min.T-11T, Min.T-14T, 1T-
Max.T, 2T-Max.T, 3T-Max. T, 4T-Max.T, 5T-Max.T, 6 T-Max.T, 7T-Max.T, 8T-Max.T, 9T-
Max.T, 10T-Max.T, 11T-Max.T, 14T-Max.T, ODD, and EVEN
* If you select Min.T-1T to Min.T-14T, all the symbol from the smallest symbol to 1T to 14T symbol
will be used as triggers to perform the analysis. Similarly, if you select 1T-Max.T to 14T-Max.T,
all the symbol from 1T to 14T symbol to the maximum symbol will be used as triggers to
perform the analysis. ODD denotes all odd Ts and EVEN denotes all even Ts.

Executing the Analysis (Calculate)

If you click the Calculate button when the measured data is already loaded, the data matching
the specified data extraction conditions is extracted, and the histogram or the list of statistics is
displayed using the specified display format of analysis results (see section 3.1).

The Calculate button becomes available only when a possible data extraction condition is
specified. For the possible data extraction conditions, see “Selectable Triggers and
Extracted Data” on pages 6-2 and 6-3.

Note
» Analysis is performed and the histogram or the list of statistics is displayed using the display
format of analysis results also when the measured data is loaded after setting the data
extraction conditions.
« If you execute data clear (Setup > Clear Data), the loaded measured data is also cleared, not
just the histogram and the statistical results.

IM 704223-61E
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3.2 Setting the Data Extraction Conditions and Executing the Analysis

Phase Adjustment Resolution

You can set a phase difference between the Ch A pulse edge and the Ch B pulse edge in
the range of —99.99 ns to 99.99 ns for the loaded measured data of the A-to-B time
interval measurement on the TA720. You can set the resolution to 0.01 ns (default), 0.1
ns, or 1 ns.

3-8 IM 704223-61E



Chapter 4 Data Analysis on Matrix

4.1 Setting the Display Format of Analysis Results

Procedure
Selecting the Matrix Display
1. From the View menu, choose Matrix.

¥ Int
F Setup | Wiew Display Help
= %‘ HE Histogram
Trigger J

S —

Cirl+H

Selecting Sheet Display or Graph Display and Selecting Statistics

2. Select Statistics Average, Statistics Deviation, Statistics Jitter, Graph, Bar
Deviation, or Bar Jitter.
Sheet display: Statistics Average, Statistics Deviation, or Statistics Jitter
Graph display: Graph, Bar Deviation, or Bar Jitter

@ Optical Digk Inter-Symbol Interference Analy it
File Setup | Wiew Display Help

I = & [ | Histoeram Ctrl+H
[Trigger B Matrix Ctrl+M
Gk B2 Histosram & Table  Shift+T
Cl @ {a8 Histoeram Graph ShiftsR
TA720 Puls
10000 Salal Al Graph Shift+H
E St
ﬁ Statistics Deviation Shift+E
ﬁ Statistics Jitter Shift+J
| Graph Shift+G
bel Bar Deviation Shift+B
E Bar Jitter Shift+]

Zooming When Displaying the Graph (only when Graph is selected in the above
procedure)

3. To zoom the display, choose Zoom from the View menu.
Choose Zoom again to return to the original display.

| Graph Shift+G
Bar Deviation Shift+B
E Bar Jitter Shift+]
[P Pulse Width Shift+P
TI Time Interval Shift+L

Showing or Hiding the Time Scale Display and the Graph Explanatory Notes

4. To show the time scale on the X-axis, choose Time Scale from the View menu. To
show the graph explanatory notes, choose Explanatory Notes.
Time Scale is valid only when Graph is selected at step 2.

Zoom Cirl+2 Zoom Cirl+2

k Cirl+U Time Scale Crl+U
Cir+E Explanatory Motes Ctrl+E

Explanatory Motes

Detailed Settings of the Matrix Display
5. From the Display menu, choose Option.

ﬁ'lﬁ]ptiu::al Dizk Inter-Symbol Interference fn

F Setup  Miew | Display Help

= %‘ H H’ é fnalysiz Mode... Shift+M |,
Trigger I sp: Windowy.. Shift+itf
ChA

Option Shift+0

rm Comment... Shift+C
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4.1 Setting the Display Format of Analysis Results

6. Inthe Option dialog box, select the Matrix, Matrix-Ave., Matrix-Dev., or Matrix-
Jitter tab, and enter various settings in the displayed dialog box.
e Matrix tab settings
Matrix tab

Histogram — Matrix |Matrix-Graph I Matriz-Disy. I Matriz-Jitter I Phase I

—Table origin——————————————————
(* Left-Top  { Left-Bottom |

STATE 2L
3T él
ﬂ ST14T (S
—Dizplay shape
(+ Bar " Rectangle Piel
=, i I

E TN

~—

¢ Matrix-Graph tab settings
Turn ON/OFF all data

Matrix-Graph tab

Histogtam | Matrix ~ Matrix-Graph |Matrix-Dev. | Matrix-Jiter | Phase |

¥ Data . Colar |
— Gradation
¥ Gradstion B Over 5
1 a
 —

Ia/Average

l_Aorizontal ling:

¢ wertical line

[l
Ok Cancel I

Set the origin of the matrix table

Select the data display shape
of the graph

Turn ON/OFF the collective range
setting of the measured data
analysis of PW—TI

Collectively set the range of the
measured data analysis of
PW—TI

When displaying all data using different colors according to the data frequency

When changing the data

color when not displaying

all data using different colors
according to the data frequency

Turn ON/OFF the average values

When changing the color of the
average values

Turn ON/OFF the horizontal
trend display

When changing the color of the
horizontal trend display

When changing the color of the
vertical trend display

Turn ON/OFF the vertical trend
display

4-2
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4.1 Setting the Display Format of Analysis Results

e Matrix-Dev. tab settings (Bar Deviation display settings)

Matrix-Dev. tab

Histogram | Matrix | Metrix-Graph Matrix-Dev. !Matrix-d'rt‘ter | Phase |

When changing the color of the values
that are outside the specified values
on the positive side

When automatically setting the range

Set the positive threshold level of
the specified values

When changing the color of the
specified values

—Deviation Colar —Borders —Range
Positive(+) error - Color._l Upper border F =i
(Positi o (Max=Ti2
Min=-Ti2)
10
e hdaedimum
Good Colar.. | I 20 ns
- Lowver border
[Good&Megative) Winimum
I— l—/
-10 nz -20 nz
Megstivel-) errar - Colar..

\

When manually setting the range

Set the negative threshold level
of the specified values

coct_|

When changing the color of the
values that are outside the specified
values on the negative side

e Matrix-Jitter tab settings (Bar Jitter display settings)

Matrix-Jitter tab

Histogram | Matrix | Matrix-Graph | Matrix-Dev. Matric-Jiter |Phase |

—Select unit

* Time [ ns) ("'Perc:ent(%)l

—Jitter color —Safety borders —Range

Etror . Color..l Wgppey (amietsr |7/AUTU
(Erptr & Safe) (Max=Upper horder x 2,
35 ns |15 % Min = Ons £ 0%

[ Safe & Good)

1 o
Safe |:| Color..l Lowver border
|2D \TS |2D j%

|1?.5 ns |10 % | | Minimum
Good . Color..l IU_ - ID_JX:

coct_|

7. Click OK.
To cancel the setting, click Cancel.

Select the jitter unit

When changing the color of the error values
When automatically setting the range
Set the positive threshold level

When changing the color of the safe values

When manually setting the range

Set the negative threshold level
When changing the color of the good values

IM 704223-61E
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4.1 Setting the Display Format of Analysis Results

Explanation

Selecting Sheet Display or Graph Display and Selecting Statistics

e Sheet Display
Three different types of sheet displays are available: average of each symbol
(Statistics Average), deviation (Statistics Deviation), or jitter (Statistics Jitter).
In the sheet display, the analysis results are displayed in a matrix where the previous
data () is shown on the Y-axis and the subsequent data (X) on the X-axis from the
data extracted according to the specified extraction conditions. The top section
displays the statistics of the previous data (Y) symbol. The middle section displays the
statistics of the subsequent data (X) symbol. The bottom section displays the number
of data points of the applicable matrix.
Example of Deviation Analysis of Space-Mark Data Immediately Before 3T Space

T T T a 5T
0.371 3.280 | -1.024
¥ 0 561 326 253
T
Statistical values of Y
0 0 0 0 o1
3T --- -1.082 -1.328_|_— Gtatistical values of X
-2.223 1839 | CTAT>+—0T17 |
535 o 213 J3> 2 Number of data points
am 0019 | -0@az 2.258
-0.001 -1.051 1685 | -2.026
374 0 129 96 B3
5T 3582 | -3372 | 01186
P TTY — -ni1a 2 aRn -1 272

e Graph Display
Three different types of graph displays are available: All data (Graph), deviation (Bar
Deviation), and jitter (Bar Jitter).
All data (When Graph is selected)
Selectable only when the applicable measured data is set to pulse width (see section
4.2 for the setup procedure). All the measured data points are displayed as dots. If
the Gradation check box in the Matrix-Graph dialog box is selected, the data is
displayed using different colors according to the frequencies of occurrence. In
addition, the average values of the combination of symbols and the trend of the
average values can be displayed using a line plot connecting twice the deviation
values (see page 4-6).

Dafa fo Data Deviation Matrix of Intfer—Symbel nferference

T Ave

Yertical lime | 4T
yTx2
*Tx2
-
Horizortallline

Average (for 3T Space-5T Mark)

Trend display
All data (for 3T Space-3T Mark)

(Line plot connecting twice the deviation values)
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4.1 Setting the Display Format of Analysis Results

Deviation or Jitter

Determines whether the deviation or the jitter of each symbol is high or low with
respect to the two specified levels and displays the result using bar, rectangle, or pie
graph in color.

Bar display example

®T
2T aT AT 18 6T T aT
i
2T .
aT —_—t—mm L — = =
AT = — e |- - - =

Zooming the Graph (only when the displayed information is Graph)

When zoomed, the display is zoomed and the display range is cut by approximately half.
For example, if 3T to 14T data is displayed and the display is zoomed, 3T to 7T data is
displayed.

Before zoom After zoom

14T

s =4 2] L T
3T 4T 8T T 7T 8T 9T 10T 11T 14T
X

Time Scale Display of the X-Axis

Select whether to display the time scale on the X-axis as shown in the following figure.
= L

Explanatory Notes
Select whether to display the explanatory notes of the sheet or graph as shown in the
following figure.

Sheet explanatory notes example Graph explanatory notes example

5T-taxT ®T
-2.979 ¥T Deviationins)

a748 ¥T Mumber fverage

--- yT yT Deviation{ns) —Horizontal line

.- YT Deviationins) ¥T Deviation{ns) Verical line

1] YT Mumber MumberiTyT)

-1 747
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4.1 Setting the Display Format of Analysis Results

Detailed Settings of the Matrix Display
e Matrix Table Origin
You can select Left-Top or Left-Bottom.

(* Left-Top  { Left-Bottom
STATE 2L

3T él

ﬂ ST14T (S

¢ Selecting the Data Display Shape of the Graph
Select Bar, Rectangle, or Pie.
Bar

18.500ns
¥T

=

18.500ns

18.500ns
®T

=

18.500n5

Rectangle

Pie

18.500ns 18.500ns

18.500ns
¥T

*T

18.40)

18.500ns
¥T

*T

nons 18.500ns

-18.500ns

-18.500ns

¢ Collective Range Setting When Analyzing Measured Data of PW—TI (Display

grouped T (PW->TI))

When the measured data of pulse width A—A-to-B time interval measurement on the
TA720 is being analyzed the data of the specified T range (1T-Max.T to 14T-Max.T) is
displayed collectively.

For example, the following figure shows the case when 5T-Max.T is specified.

AT T 3T 4T 5T-MaT
-1.261 -1 554 -2.4879
¥ i 551 386 575
T
i i i i i
3T 0773 0016 174z
-2ATTA — - aTA -4 f07 . e b 4

Detailed Settings of All Data Display (Graph)

Turn ON/OFF all data, average values, and horizontal/vertical trend display on the
graph display and set the color of each displayed item. The display color is set to any
of the 48 basic colors or an original color you create in the Color dialog box.

In the case of all data, you can specify Gradation, a setting in which the color changes

according to the frequency of occurrence of the data (1 to 4 or Over).
I ey 5

 —
 —
= 2
I
If the Gradation check box is selected, the data is displayed using different colors
according to the frequencies.

If the Average check box is selected, the average values of the combination of each
symbol are displayed using dots.

If the Horizontal/Vertical check box is selected, the trend of the average values are
displayed using a line plot connecting twice the average values of the combination of
symbols. The trend display of the symbol assigned to the X-axis is Horizontal; the

trend display of the symbol assigned to the Y-axis is Vertical.

Details Settings of the Bar Deviation Display

Under Borders, set the upper and lower threshold levels (Upper border and Lower
border) that indicate whether the data is within the prescribed values (Good). Under
Deviation Color, set the display colors to distinguish the judgment result above. The
display color is set to any of the 48 basic colors or an original color you create in the
Color dialog box.

* Positive(+) Error: Deviation = Upper border level

+ Good: Lower border level < Deviation < Upper border level

* Negative(-) Error:  Deviation < Lower border level

4-6
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4.1 Setting the Display Format of Analysis Results

Under Range, set the range of the bar display. When set to auto range, the maximum
and minimum ranges are set to T/2 and —T/2, respectively.

T8 800 Maximum
WwT xT
Range
-18.500n= Minimum

Detailed Settings of the Jitter Display

Under Select unit, set the displayed unit on the sheet display of the jitter analysis to ns
or %.

+ Time(ns): o (standard deviation)

» Percent(%): Jitter (ns)/Tx100

Displayed in ns Displayed in %
oud u £t 1= (L] u L 12 '
a7 - 4085 3529 3. a7 . 11 068 9538 10
4487 --- 3957 3.451 3. 11316 .- 10,694 9328 10
1240 o 407 314 i 1240 i] 407 4 :
3T -~ (525 4782 4. 3T - 14205 | 12869 | 12
5344 ce | |~ 48D 3797 4. 14,443 . 12435 | 10261 1
1566 o ~ 926 354 i 1566 i] 526 354 :
T - --- --- - 27
0 0 0 i o il i i

T a1 ar 47 5 T o7 3T 4T 5

. 4.403 3634 3. . 11,801 9.521 10
T 0 1589 1198 i «T 0 1589 1198 £

Number of data points
Jitter of X-axis T

Jitter of Y-axis T

On the graph display, the following judgment is made with respect to the two specified
levels, and the result is displayed using different colors. Under Safety borders, set the
threshold levels (Upper border and Lower border). Under Jitter Color, set the display
colors to distinguish the judgment result above.

 Error value: Jitter = Upper border level

» Safe value: Lower border level < Jitter < Upper border level

» Good value: Jitter < Lower border level

Under Range, set the range of the bar display. When set to auto range, the maximum
and minimum ranges are set to T/2 and —T/2, respectively.

P70 000n= — Maximum
wT
Range
— Minimum
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4.2 Setting the Data Extraction Conditions and
Executing the Analysis

Procedure
Selecting the Measured Data to Be Analyzed (only on the TA720)
1. If the measured data to be analyzed is pulse width, choose Pulse Width from the
View menu. If the data is A-to-B time interval, choose Time Interval.
E’a’l:lptin::al Dizk. Int ywmbol Interference Anal f
File Setup | Wiew Display Help
= & [ | Histoeram Ctr+H g = & [ | Histoeram Ctr+H g
[Trigger B Matrix Cubh [ ITigger [ Matrix Cubh [
Gk B2 Histozram & Table. Shifen I Gk 55| Histoeram & Tebler ShiftsT i
ChB r a8 Histoeram Graph shift+R | ChB a8 Histoeram Graph Shift+R
TAT20 Fuls - TAT20 Fuls -
10000 Salal All Graph Shift+H 10000 Salal Al Graph Shift+H
fEE Statistics fweraee. shifted fEE Statistics fverage  Shiftey !
[EE sStatistics Deviation  Shift+E [EE Statistics Deviation  Shift+E
ﬁ Statistics Jitter Shift+d [ ﬁ Statistics Jitter Shift+d [
|. Graph Shift+G | |§ Graph Shift+G |
Bar Deviation Shift+E bel Bar Deviation Shift+E
E Bar Jitter Shift+ | E Bar Jitter Shift+ |
S Pulse Width Shift+P [P Pulse Width Shift+P |
T| Time Interval Shift+L m Time Interval Shift+L
Setting the Data Extraction Conditions
2. Set the data extraction conditions using the trigger bar shown below.
When the measured data of pulse width A—A-to-B time interval measurement of the
TA720 is loaded, phase adjustment is possible using the Phase text box.
¢ When the Data to Be Analyzed Is Pulse Width
Select the Mark/Space to be used as a trigger
Select the T symbol of the Mark/Space to be used as a trigger
Execute the analysis
I I I
; L L |
Trigger [T ggace [ B =l space [an Wl =l |
cha Calculate
cha r s I‘I’X Phase| 000 :Il ns
Y-axis assignment display X-axis assignment display
Display extracted data (auto setting)
* When the Data to Be Analyzed Is A-to-B Time Interval
Select the Mark/Space to be used as a trigger
Select the T symbol of the Mark/Space to be used as a trigger
| | Execute the analysis
Trigger Space I\” =l e wark |3T =l i snace IA” 2 e IA” =l | |
cha Calculate
che - W % Phase| .00 = ns

g
|

Display extracted data (auto setting)

Executing the Analysis
3. Click Calculate.

Adjust the phase
X-axis assignment display

Y-axis assignment display

The Calculate button becomes available only when a possible data extraction

condition is specified.

4-8
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4.2 Setting the Data Extraction Conditions and Executing the Analysis

Explanation

Changing the Phase Adjustment Resolution
The setup procedure is the same as with the data analysis using histograms. See page 3-6.

Selecting the Measured Data to Be Analyzed (only on the TA720)

When performing analysis on the measured data of the pulse width A—A-to-B time
interval measurement of the TA720, select whether the analyzed data is pulse width or A-
to-B time interval.

Data Extraction Conditions
¢ When the Data to Be Analyzed Is Pulse Width

Set whether to use a Space or a Mark as a trigger. Whether the Space-Mark or Mark-
Space data immediately before the trigger or the Space-Mark or Mark-Space data
immediately after the trigger is extracted is automatically specified according to the
position of the specified Space or Mark. The Y and X displayed next to the check
boxes indicate the axes on the matrix display.

Example When Mark-Space Data Immediately after All Space Is Extracted

Trigger v Epace [Al | e Jan | rospace [0 7] o fan v

ChA — —
r ciEg I % P

ChB

Example When Mark-Space Data Inmediately before 3T Space Is Extracted

Trigger =) Epace Al Tl T tfark IA” 'l ¥ Space |3T | T wark Al -
cha — ——
ChE F oy v 3 r -

When the Data to Be Analyzed Is A-to-B Time Interval

When extracting all the measured data of A-to-B time interval measurement, select
one of the three check boxes located on the same line as Ch B (a single check box
when the slope setting of the measured data is not both). The axes assignment of
Space/Mark on the matrix display is determined by the selected check boxes. The Y
and X displayed next to the check boxes indicate the axes on the matrix display.
Example When All the Measured Data of A-to-B Time Interval Measurement Is
Extracted

Trigger [ Space |4 1T mark IA” 'l [~ Space |27 T T Mark |2 -
cha aEE— aEE—
che " X r - PI

When using a Space or Mark as a trigger to extract the measured data of A-to-B time
interval measurement from the Space-Mark or Mark-Space edge immediately after the
trigger, select the Space or Mark check box located on the same line as Trigger. Then,
select one of the two check boxes located on the same line as Ch B (a single check
box when the slope setting of the measured data is not both). The axes assignment of
Space/Mark on the matrix display is determined by the selected check boxes. The Y
and X displayed next to the check boxes indicate the axes on the matrix display.
Example when extracting A-to-B time interval from the Mark-Space edge
immediately after 3T Space

Trigoer V¥ Space |3T >\l T wark IQT 'l I~ Space |3T | T mark Al M
cha a— oEEE——
che o P * r Ft

When using a Space or Mark as a trigger to extract the measured data of A-to-B time
interval measurement from the edge on each end of the trigger, select the Space or
Mark check box located on the same line as Trigger. Then, of the three check boxes
located on the same line as Ch B, select the check boxes corresponding to the edge
on each end of the Space or Mark set to be the trigger. The axes assignment of
Space/Mark on the matrix display is determined by the selected check boxes. The Y
and X displayed below Space or Mark indicate the axes on the matrix display.

IM 704223-61E
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4.2 Setting the Data Extraction Conditions and Executing the Analysis

Example when extracting A-to-B time interval from the edges around 3T Mark

Trigger =| Epace |3T 1 ¥ mark |3T 'l I=| Epace |3T | T wark A -
cha C— C—
ch.B ﬁ—*—|—/ I M Pr
Y Space X Space
X Space
AT T T aT
-1.910 .78
¥ 0 551 416
T
0 0 0 0
Y Space £ o723 | It
-2.181 -2.974 -2.8%
526 0 176 147
aT 2179 R

T Symbol of Space/Mark to Be Used As a Trigger
You can select from the following.
All, 1T, 2T, 3T, 4T, 5T, 6T, 7T, 8T, 9T, 10T, 11T, 14T, Min.T-1T, Min.T-2T, Min.T-3T, Min.T-
4T, Min. T-5T, Min.T-6T, Min.T-7T, Min.T-8T, Min.T-9T, Min.T-10T, Min.T-11T, Min.T-14T, 1T-
Max.T, 2T-Max.T, 3T-Max. T, 4T-Max.T, 5T-Max.T, 6T-Max.T, 7T-Max.T, 8T-Max.T, 9T-
Max.T, 10T-Max.T, 11T-Max.T, 14T-Max.T, ODD, and EVEN
* If you select Min.T-1T to Min.T-14T, all the symbol from the smallest symbol to 1T to 14T symbol
will be used as triggers to perform the analysis. Similarly, if you select 1T-Max.T to 14T-Max.T,
all the symbol from 1T to 14T symbol to the maximum symbol will be used as triggers to
perform the analysis. ODD denotes all odd Ts and EVEN denotes all even Ts.

Executing the Analysis (Calculate)

If you click the Calculate button when the measured data is already loaded, the data
matching the specified data extraction conditions is extracted, and the matrix sheet or
graph is displayed using the specified display format of analysis results (see section 4.1).
The Calculate button becomes available only when a possible data extraction condition is
specified. For the possible data extraction conditions, see “Selectable Triggers and
Extracted Data” on pages 6-3 and 6-4.

Note
 Analysis is performed and the matrix is displayed using the display format of analysis results
also when the measured data is loaded after setting the data extraction conditions.
« If you execute data clear (Setup > Clear Data), the loaded measured data is also cleared, not
just the analysis results.

Phase Adjustment Resolution

Phase adjustment in the range of —99.99 ns to 99.99 ns is possible with respect to the
measured data of pulse width A—A-to-B time interval of the retrieved TA720. The
resolution can be set to 0.01 ns (default), 0.1 ns, or 1 ns from Phase tab > Phase
adjustment resolution in the Option dialog box that opens when Display > Option is
chosen.
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Chapter 5 Saving/Recalling Data and Printing Analysis Results

5.1 Saving the Statistical Calculation Results

Procedure

Explanation

1. To save the statistical calculation results of histogram analysis, choose Save
Statistics (Triggered T) or Save Statistics (All Triggered T) from the File menu. To
save the statistical calculation results of matrix analysis, choose Save Matrix
Statistics. The Save As dialog box opens.

[E Optical Disk Int smbal Interference An s [E Optical Disk Int ol Interference An

Eile Setup View Display Help File Setup Miew Display Help

= Open.. Crl+0 = Open.. Crl+0

%‘ Open Fram Communication... Citrl+G %‘ Open Fram Communication... Citrl+G
Camm / Data File List.. Citrl+L Camm / Data File List.. Citrl+L

Triggered Ti. k Cirl+T Save Statistics (Triggered Th. Cirl+T
Save Statiztics (Al Trigeered T). Citrl+f 5 (&1l Trigeered ). kl:itrlﬂ'-\
Sayve Matrix Statistics.. Girl+h Sayve Matrix Statistics.. Girl+h

er-Symbol Interference An
File Setup Miew Display Help

= Open.. Citrl+0

%‘ Open Fram Communication... Ctrbg |
Camm / Data File List.. ctrisl
Save Statistics (Triceered Ti. Ctel+T |
Save Statiztice (Il Trizeered T Citel i

Cirl+M

2. After setting the Save in box, enter the name of the file you wish to save in the File
name text box.

3. Click Save.
To cancel, click Cancel.

{RIEFBBAQ [ TestData = B E

@test‘l oEY

Frd B ftest2.cev =l R ), |
FrAL@FEERD:  [STAT-file feosv) =l St |

Data to Be Saved

During histogram analysis, you can save the data extracted according to the specified
extraction conditions (Triggered T) or the data extracted according to all trigger conditions
(All Triggered T). However, all the data (All Triggered T) can be saved only when a Space
or Mark is used as a trigger to extract the data around the trigger (inter-symbol
interference analysis extraction mode on the TA is set Single).

Saved Contents

In addition to the statistics, the comment, the setup data (window width, data analysis
conditions, data accumulation number, and data extraction conditions), and the date and
time when the data is saved are saved.

IM 704223-61E
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5.1 Saving the Statistical Calculation Results

Data Format and File Name
The data is saved in CSV format. The file name can be any legal file name as defined by
the operating system. The extension is .csv.
+ Histogram analysis example

A | B [ ¢ [ o [ E T F
| 1 |Model 704223
| 2 |
3 |Modulation 1 =7madulation
4 |Palarity Spacel+) Mark(=)
B | Accumulation )
6 |Date 2002412412
7 |Time 15:06:35
| g |
5 |Analysis Function Pulze Width
10
11 [Triceer Condition
12 |Polarity Space Mark Space Mtk
13 [Trieger 3T
14 |Target Selected
15
16 |window Left Right
17 [unit nsec nzec
18 |e7 555 az5
19 |7 925 1205
20 |47 1295 1665
21 |sT 1665 2035
22 |7 2035 2405
23 |77 2405 2775
24 a7 2775 3145
25
28 [TraceMame Average D viation Jitter Mumber
27 |unit nsec nsec nzec
28
20 |l Space Data
30 |eT --- --- --- i
31 a7 109.424 -1576 5344 1566
32 |at 149.249 1.243 4187 1240
33 |s7T 182841 -21549 4,066 200
34 |sT 218818 -3.182 3012 610
35 |7 267.252 -1.748 4043 361
36 a7 296.236 0.236 3040 206
| 37 |
| 38 |Selected Space Data
| 39 |21 --- --- --- ]
| 40 |31 111.352 0352 5148 551
+ Matrix analysis example
A | B c | o | E | F G H |
1 [Model 704823
| 2 |
| 3 |Modulation 1 =7 modulation
4 |Palarity Spacel+) Mark(=)
D |Accumdlstion b
6 |Date 2002412412
7 |Time 15:07:12
| g |
5 |Analysis Function| PW->TI
10
11 [Trigger Condition |Polarity Space Park, Space Park,
12 |[Trieger 3T
13 |Tareet N x
| 14 |
15 |window X Left X Right Left *fRight
16 [unit nsec nsec nzec nzec
17 |1 555 az5 555 az5
18 |37 az5 1205 az5 1205
18 |47 1205 1665 1205 1665
20 |sT 1665 2035 1665 2035
21 |sT 2035 2405 2035 2405
22 |17 2405 2775 2405 2775
23 |e7 2775 345 2775 3145
| 24 |
| 25 |TraceMame Average
| 26 |tz v
| 27 |unit nzec
| 28 |
20 |window 2T 3T 4T 5T 6T 7T aT
30 |7 --- --- --- --- --- --- ---
31 a7 --- 17.777 16.223 16538 15.411 14612 16528
32 |4t --- 16.315 14378 13823 13500 14.261 165163
33 |57 --- 17.504 16568 15018 14066 165.78 144
34 |sT --- 17.677 15,798 15.028 15.845 16.025 16.75
35 |77 --- 18212 14.495 14944 16.388 15.063 1412
36 |s7 --- 16.039 15.252 14.436 12517 13.754 16.663
| 37 |
38 [TraceMame Dz wation
39 |auds b
40 |unit nsec
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5.2 Saving and Loading Setup Data and Measured
Data

Procedure
Saving
1. To save only the setup data, choose Save Setup Data from the File menu. To save
both the measured data and setup data, choose Save Measured Data & Setup.
The Save As dialog box opens.

¥ Cptical Digk Inter-Symbal Interference Anal o ¥ Cptical Digk Inte mbol Interference An:

File Setup Miew Display Help File Setup Miew Display Help

= Open.. GtrO = Open.. GtrO

%‘ Open From Communication.. Cirl+G %‘ Open Fram Communication... Cirl+G
Camm / Data File List.. Grl+L Camm / Data File List.. Ctrl+L
Save Statistics (Triceered Ti. Crl+T Save Statistics (Triceered Ti. Crl+T
Save Statiztice (Il Trizeered T Ctrlrf Save Statiztice (Il Trizeered T Ctrlrf
Save Matrix Statiztics... Citr[+M Save Matrix Statistics.. Citr[+M

p Data.. k Ctrl+5 L Save Setup Data.. Citrl+5

Load Setup Data.. Citrl+L | Load Setup Data... Citrl+L |

H’ Save Measured & Setup Data.. Shift+s5 ﬂ : ed tup Data... Shift+s

H Load Meazured & Setup Data.. Shift+L H Load Measured & Setup Data.. Shift+L

2. After setting the Save in box, enter the name of the file you wish to save in the File
name text box.

3. Click Save.
To cancel, click Cancel.

s)nsay sisAjeuy bunuud pue ejeq buijjesay/buines

2|
Save in: I@ testdata j - £ B
| testl,cfg
QtestZ.ch
QtestS.ch
Qtest‘l.cfg
File name: Itest5.cfg j Save
Saveastype:  |CONFIGHik [*.cfg) =] Eaa] |

Loading

4. To load only the setup data, choose Load Setup Data from the File menu. To load
all data and setup data simultaneously, choose Load Measured Data & Setup. The
Open dialog box opens.

mbol Interference An:

File Setup Wiew Display Help File Setup View Display Help
& Open.. Ctr+0 & Open. Crk0 ||
B Open From Communication. Crl+G (2" Open From Gommunicatian.. Crl+G
Comm # Data File List.. Citrl+L Gomm # Data File List.. oL Ml
Save Statistics (Trieered Ti. Gtel+T] Saye Statistice (Triggered T. G+ |
Save Statistice (1] Triceered| T, Site ]+ Save Statistics (] Triseered Ti. Citrl+f
Save Matrix Statistics.. it [+ Save Matrix Statistics. Citr [+
Save Setup Data.. Grl+5 Save Setup Data.. Ctrl+a
Ctrl+L ﬁ Load Setup Data.. Ctrl+L f
H’ Save Measured & Setup Data.. Shift+5 Shift+5
B Load Measured & Setup Data.. Shift+L oad Measure Shift+L
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5.2 Saving and Loading Setup Data and Measured Data

Explanation

5. After setting the Look in box, select the file name from the file list.
You can also enter the name of the file you wish to open in the File name text box.

6. Click Open.
To cancel, click Cancel.

2|
Look in: I@ testdata j - & EB-
testl.cfg
test2.cfg
testS.CFg
Iy Computer y
File name: Itest4.cfg j Open
Files of type: IEDNFIG-fiIe [*.cfg) j Cancel |

[ Open as read-only

Saved/Loaded Contents

You can save/load only the setup data or both measured data and setup data collectively.

* Measured data:

Loaded measured data. If the number of times to load the data is

specified, the accumulated data are saved or loaded.

+ Setup data:

Window width, data analysis conditions, data accumulation number,

data extraction conditions, comments, display format of analysis

results, etc.

File Name and Extension

The file name can be any legal file name as defined by the operating system.

» Extension of the measured data file name: .mds
» Extension of the setup data file name: .cfg

Precautions to Be Taken When Saving and Loading Data

» When the loaded measured data and setup data are saved simultaneously, the header
file (.hdr extension) is also created along with the setup data file (.cfg extension). This
header file is necessary when loading the measured data and setup data

simultaneously. Therefore, make sure not to delete this file.

+ When the measured data or setup data is loaded (when Open is clicked), the
measured data or setup data existing before the load operation is cleared.

5-4
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5.3 Printing the Analysis Results

Procedure
Setting Up the Printer
1. From the File menu, choose Print Setup to open the Print Setup dialog box.

=g bol Ir
File Setup Miew Display Help
= Open.. G+ |
%‘ Open Fram Communication... Ctrbg |
Camm / Data File List.. owkl N
Save Statistics (Trizgered TI. Ctr+T |
Save Statiztics (G Trizeered T Cirl+
Saye Mattix Statistics.. il
Save Setup Data.. Citrl+5
Load Setup Data.. Ctri+L ¢
H’ Save Measured & Setup Data.. Shiftvs ¢
H Load Measured & Setup Data.. Shiftsl [
Cirl+F
Cirl+R, E
Cirl+ ¢
Print Option... Citrl+]

2. Set the printer, orientation, paper size, etc. Then, click OK.
21

— Prirter
Mame: Froperties... |
Status: Feady

Type: Canon PS-IPU Color Lazer Copier ¥52.3
Wwhere:  A\WPSZHESPrint

Comment:
— Paper Orientation
Size: ILetter j & Portrait
B
Source: IAutomaticaIIy Select j " Landscape

Metwork. .. | oK I Cancel

s)nsay sisAjeuy bunuud pue ejeq buijjesay/buines

Specifying Print Options
1. From the File menu, choose Print Option to open the Print Option dialog box.

=g 0] bol Ir

File Setup Miew Display Help

= Open.. G+ |

%‘ Open Fram Communication... Ctrbg |
Camm / Data File List.. owkl N
Save Statistics (Triggered Ti. Ctr+T [
Save Statiztice (Il Trizeered T Citel i
Sayve Matrix Statistics.. Girl+h
Save Setup Data.. Ctr+s  F
Load Setup Data.. Ctri+L ¢

H’ Save Measured & Setup Data.. Shiftvs ¢

H Load Measured & Setup Data.. Shiftsl [

& Print.. Cirl+P |

D Print Setup... Cirl+R,

& Print Prexiew Cirl+\
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5.3 Printing the Analysis Results

2. Use the Printer Color option button to select Color or Mono Tone.
- x|

Print Calar
’7 * Calor " Maona Tone

Cancel

3. Click OK.

Print Preview
1. From the File menu, choose Print Preview.

File Setup Miew Display Help

= Open.. G+ |
%‘ Open Fram Communication... Citrl+G
Camm / Data File List.. owkl N
Save Statistics (Triggered Ti. Ctr+T [
Save Statiztice (Il Trizeered T Citel i
Sayve Matrix Statistics.. Girl+h
Save Setup Data.. Citrl+5
Load Setup Data.. Ctri+L ¢
H’ Save Measured & Setup Data.. Shiftvs ¢
H Load Measured & Setup Data.. Shiftsl [
Bleee ot ]
D Print Setup... Ctrl+R i
& Print Prexiew Ctrl+y ¢
Print Option... Citrl+]

A window appears for checking the print image as shown below.

[ Optical Disk Inter-Symbol Interference Analysis Software

Print.. | MewtPaoe | PrevPage | TwoPage | Zoomin | Zoomiuw | Closs |

—
BB T AR

Note
» To check the print image in detail, click Zoom In. Click Zoom Out to return to the original size.
« Click Print to open the Print dialog box.
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5.3 Printing the Analysis Results

Executing the Print Operation
1. From the File menu, choose Print to open the Print dialog box.

P Cptical Int 0 Erence

File Setup View Display Help

= Open.. G+ |

%‘ Open Fram Communication... Citrl+G
Camm / Data File List.. owkl N
Save Statistics (Triggered Ti. Ctr+T [
Save Statiztice (Il Trizeered T Citel i
Sayve Matrix Statistics.. Girl+h
Save Setup Data.. Ctr+s  F
Load Setup Data.. Ctri+L ¢

H’ Save Measured & Setup Data.. Shiftvs ¢

H Load Measured & Setup Data.. Shift+L

Bleee ot ]

D Print Setup... Ctrl+R i

& Print Prexiew Ctrl+y ¢
Print Option.. Cirl L

2. Confirm the settings in the Print dialog box and click OK.
21x|

— Prirter
Mame: Froperties... |
Status: Feady

Type: Canon PS-IPU Color Lazer Copier ¥52.3
Wwhere:  A\WPSZHESPrint

Comment; [ Pririt b file
r— Print range Copie:
oAl Mumber of copies: |1 3:

" Pages from:|1_ t0:|1—

= Selection Ijl

QK. T, Cancel

Explanation
Setting Up the Printer

s)nsay sisAjeuy bunuud pue ejeq buijjesay/buines

Set the printer according to the system environment that you are using.

Specifying Print Options

You can select whether to print in color or in black and white (Mono Tone).

« Color: Color printing (gray-scale printing on a black and white printer)

* Mono Tone: Black and white printing (On the graph display of jitter matrix analysis,
good, safe, and error are displayed in white, stripes, and black,
respectively)

IM 704223-61E -7



5.3 Printing the Analysis Results

Histogram Print Example (The following figure is an image.)

TAF20 PulseWidth&Timelnteryal Chi ChB Both-=Rise
10000 Sample Data Accurmulation 171
Trigger Condition

Falarity Space hark Space hark
Trigger 3T
Target(FW) Selected
Data to Data All Space Statistics
Btat Tl 2T 3T AT aT 6T iT 8T
Ave.[ng] 109.424 | 199233 | 210085 | 265558 | 310563 | 365.971 405.095
Dev.[ns] 3.636 0.851 -1.480 -5.912 -6.500 0287 -18.086
Jitterfns] 5.344 15.189 14.450 7.533 18.062 3877 4.423
Hurn 1566 1812 843 376 303 54 10
Data to Data Selected Space Statistics
Gtat Tl 2T 3T AT aT 6T iT a7
Ave [ns] 109.079 | 157825 | 209404 | 258706 | 312011 370.144 | 403931
Dev.[ns] 3.292 -0.857 =272 -5.763 -5.352 0113 -19.220
Jitterfns] 4.852 14.754 15.054 7.041 15.044 4.400 1.5987
Mum 538 B27 265 135 110 21 4
Data to Data All & Selected Space Histogram —All
ua. - - - - Selected
" H i 1 Lo Left
i : i A Right
o H i i - s Center
i’ : i P orhverage
SDDIn
Optical Disk Inter-Symbol Interference Analysis Software FOKOGAWA

*

5-8
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5.3 Printing the Analysis Results

All Data Matrix Print Example (The following figure is an image.)

TAS20 PulseVWidth&Timelnteryal Cha ChEB Both-=Rise
10000 Sample Data Accumulation 171
Trigger Condition

Palarity Space Mark Space Mlark
Trigger 3T
Target Y Axis A

Data to Data Deviation Matrix of Inter-Symbol Interference

=T .
Wertical line
2T "
wTx2
e
- e X x‘“ﬂ"""—-\_ e . T2
e - B\ ]
P . | HENELRUVLL S o - B ] Horzental line
aT)

4T g.—_‘z_____ _B_g- / »
e e -]
aT
W’W‘EH‘—%#—F’M ) 5
2] B I W (AU U %
1D?ns Z'EOIns SJ?ns 4:I3|ns ﬁj?ns g
27 aT 47 5T 6T 7T aT =2
: 5
Data to Data Deviation Matrix of Inte=-Symbaol Interference
T T aT a7 5T [ T T T o
4036 1305 2126 | 0734 | 4878 0448 0578 T Deviation(ns) =
% 567 5655 207 125 115 29 1 T Humber [
2T 068 EE] ZHET 0006 | 1687 BRI - T ¥T Devition(nz) o
3202 6 54 0223 1505 1 066 0786 2745 .- T Deviation(ns) | T Dewiation(ns) S
538 200 154 1065 29 39 10 i T Humber HurmberixT yT) o
3T 0OvZ | -1509 0313 724 B B 5007
0857 4382 0808 4982 | 1196 | 5050 015 REr] 3
627 203 219 o8 51 44 2 1 =
aT 2868 | -2828 3782 7338 G578 524 - 3
2172 3467 2438 0005 | 1277 | -10.803 6542 .- 5
265 a7 a7 4 24 14 2 i @
BT Fadr | -agis 6834 | 7083 | BAT6 0307 -
5763 5027 2565 4270 | 1764 | 2834 £ 405 .- >
135 20 53 2 1 11 H i =
BT 367 | -612% 4471 | -10566 | -4684 7707 - )
5,362 1507 2441 5504 | 34z | 0043 | 288 .- <
110 25 a7 24 10 & & i »
7T 0157 | -0B8T 314 | -3.467 5368 3
0113 3 562 12 235 6887 3632 | 24888 .- .-
21 1 g 6 2 1 i i )
aT 6076 | 18764 | 22376 1]
10,220 2012 5044 | -19551 @
4 1 2 1 0 0 0 0 %
(7]
Optical Disk Inter-Symbal Interference Analysis Software FOKROGAWA L
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5.3 Printing the Analysis Results

Deviation Matrix Print Example (The following figure is an image.

)

TA720 PulseWyidth& Timelnteryal Ch& ChB Both->Rise
10000 Sample Data Accumulation 171
Trigger Condition

Palarity Space Ilark Space Mlark
Trigger 3T
Target Y Axis ¥ Axis

Data to Data Deviation Matrix of Inter-Symbol Interference

=T
27 a7 47 a7 &T T aT T
T
2T e e Rt —— e — |- - |-y - e
3T e — e e — e =
AqTns ATns
T T =T
aT — | —_—_ = — = | —= ..______
5T e =y —
26.99 ns | - 25947 ng
&T —_—— ==, = g [ —
_Posiﬁ\ne Errar
Upper border 10000000 =)
AT N U ) P — LA R
Lowver barder -10.000(n=])
M eg ative Errar
2T R et B e Rl B SRRt

Datato Data Devigtion Matrix of Inter-Symbaol Interferance
T T T a7 5T 6T T T T
\ 4036 1305 2126 | D734 | 4878 | 0ade | 0378 «T Deviation(ns)
% 567 565 207 125 115 20 1 T Humber
T 3068 F860 S DO06 | 1687 | 2708 - T VT Deviation(ns)
3.202 6 554 0323 A5DS 1,66 0786 | 2746 e T Dewiationfns) | «T Dewiationfns)
538 200 154 106 20 30 10 i 3T Humber Hurnber T 3T}
3T Do7Z | -1508 0313 7241 478 | 5665 | 9007
0557 4382 0808 498z | 1196 | 5050 0815 9376
627 203 219 oz 51 44 a 1
aT 2568 | -1828 3762 7338 4578 78I I
2172 3467 2438 0805 | 1277 | 100803 6 543 e
265 a7 a7 4 24 14 2 i
5T T | -4mi3 B34 | 7083 | 646 | B.E07
5763 5027 2565 4270 | 1764 | 2834 5405 e
138 29 53 21 9 11 2 i
BT 35T | B2 471 | -10566 | 4684 7707 I
5352 1507 3441 5504 | 3422 | 1043 | 2828 e
110 5 a7 4 10 & [ i
T 0157 | -DBGZ 2814 | 3467 5 368 =
0113 3562 12225 BEE7 3552 | 24888
21 1 ] 6 1 1
BT 6076 | -18.764 | 22476
10,220 2012 5044 | 19551
4 1 i 1 i i i i
Optical Disk Inter-Symbol Interference Analysis Software Y OKDGAVA,

TS
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5.3 Printing the Analysis Results

Jitter Matrix Print Example (The following figure is an image.)

TAZ 20 PulseWidth&Timelnterval Cha ChB Both-»Rise
10000 Sample Data Accumulation 171
Trigger Condition
Polarity Space Mark Space Mlark
Trigyer 3T
Target Y Axis ¥ A
Data to Data Jitter Matrix of Inter-Symbol Interference
=T
27 aT 47 5T &T 7T ar «T
T
27
- e - -
3T
- e O N . - D00 ns
wT wT =T
41
I . . O mm
5T
B e [ | Q
5T =
- . g - = - Ertor =
Upper border 35000 (ns) ‘&
7T Safa 5
- . -— Lowwer border 17 500 (=) ;)
oo d 0
a7 [
g.
Data to Data Jitter Matrix of Inter-Symbol Interference
T T aT a7 5T BT T T T o
4420 14350 | 16046 4254 | 16850 | 11653 0000 xT Jitter(ns) =
% 567 565 207 125 115 29 1 xT Humber [
2T TH THED 712 5448 054 309 - T ¥T Jiter(nz) o
4852 4517 13254 | 16512 4831 16014 | 14741 e T Jitterins) xT Jitter(ns) S
538 200 154 1065 2 30 10 i T hWumber HumnbericT 4T} o
3T 4166 | 14140 | 5008 | 17239 | 16.282 | 13351 G000
14754 | a7o4 | 14238 | 16817 3053 17.030 0508 0000 3
627 203 219 [ 51 44 [ 1 =
T T56a4 | 15763 | 155640 | 11.858 7551 TFE0 I 3
15064 | 4386 14078 | 15274 3480 12.040 2735 e 5
265 a7 a7 4 4 14 2 i @
i 7754 5020 3367 7860 0083 T4z I
7.041 3521 151060 | 16213 1.001 17,563 i e >
135 30 53 il 1 1 2 i =
BT 77603 | 17400 | 18601 | 12.686 | 18.286 | 12281 I )
1e04d [ 3y 15 841 9630 3717 14082 | 10.410 e <
110 25 a7 24 10 & & i »
7T 0000 4353 4377 0525 0.000 - . 3
4.400 0000 13 400 1801 0038 0.000 .- e
21 1 g i 2 1 i i )
BT 0 000 0458 G000 1]
1.987 0000 0188 0000 g
4 1 2 1 i i i i =
(7]
Optical Disk Inter-Symbol Interference Analysis Software Y OKDGAWA, L

IM 704223-61E 5-11



Chapter 6 Specifications

Specifications

Functional Overview
Installing the software into the PC enables measured data of TA320/TA520/TA720 to be
loaded and inter-symbol interference analysis to be performed.

Measured Data to Be Analyzed
Data measured under the following conditions

Model = Sampling Mode Measurement Function
TA320  Time stamp mode Pulse width (both polarities) measurement
TA520  Time stamp mode Pulse width (both polarities) measurement

TA720 Inter-symbol interference  Pulse width (both polarities) measurement, pulse width
analysis mode A—pulse width B measurement, or pulse width A—A-to-
B time interval measurement

Method of Loading the Measured Data
Open measured data saved to an external storage medium or directly load the measured
data by connecting the TA320/TA520/TA720 to a PC via the communication interface

(GP-IB or Ethernet network*) and starting measurements from the software.
* The Ethernet interface option is available only on the TA720.

Method of Loading the Measured Data
Data accumulation number: Up to 64 times (however, loading of data exceeding 2
Mpoints is not possible)
Communication settings (only when communicating with the TA320/TA520/TA720):
GP-IB:  Address setting
Ethernet: IP address, user name, and password settings

Data Extraction Condition Settings
Data Polarity Selection
Select Space(+)-Mark(-) or Mark(+)-Space(-)
Modulation Type Selection
Select from 8-17 modulation (EFM), 8-16 modulation (EFM+), 1-7 modulation, and
manual (arbitrarily set from 1T to 14T)
Window Settings
» Window size setup method: Select Center/Span or Left/Right for each window
»  Window value setup method: In addition to entering values, the following settings are
available:
« CD/DVD easy setting
« Auto setting using clock cycle or frequency input
+ Auto setting by estimating the clock cycle from the data
Arbitrary Setting of the Center Value of Deviation
Arbitrary set the Center values of 1T to 14T for determining the deviation

IM 704223-61E 6-1
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Specifications

Histogram Analysis
Data Extraction Condition Settings
Set the extraction mode, trigger, and extracted data visually using the trigger bar
Trigger setting: Select from All, 1T to 14T, greater than or equal to the specified T
symbol, less than or equal to the specified T symbol, Odd, and Even
Selectable trigger and extracted data:
» When the extracted data is pulse width

Trigger* Extracted Data (TARGET)**
SINGLE _ « Symbol before the ch A [Xeaxis |_TRIG D
(Trigger on a single trigger -~
symbol) TARGET
TRIG * Symbol after the trigger Ch A (_TRIG ) X-axis |
TARGET
* Symbol before and after Ch A [ X-axis [ TRIG )Y X-axis_|
the trigger - = -
TAFI!GET TAIIRGET
Analyze both
COMBINATION « Symbol before the chA [X-axis | TRIG
(Trigger on 2 trigger
consecutive symbols) TARGET
TRIG TRIG  Symbol after the trigger Ch A @RII[C TRIG ) X-axis |
TARGET
BETWEEN . ch A (TRIG ) X-axis |_TRIG
(Trigger on 2 symbols f’r‘i’mzc:l between the ¢ ) S )
separated by 1 symbol) 99 TARGET
CTrIG ) (TRIG)
Histogram display image * Reverse setting of Space/Mark
to be used as a trigger is possible.
TRIG ) — @aile
Space Mark
** During pulse width—pulse width
measurement, Ch A is used as a
trigger to extract Ch B data.
3T 4T 5T 6T 7T 8T

P X-axis
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Specifications

* When the extracted data is A-to-B time interval

Trigger

Extracted Data (TARGET)

SINGLE
(Trigger on a single

« Front edge of the trigger Ch A [ X-axis [ TRIG )

symbol

\II-I\RGET

symbol) ChB |
(CTRIG))
 Back edge of the trigger Ch A (_TRIG ) X-axis |
symbol TARGET
chB | \’|
* Front edge and back Ch A [X-axis 1| TRIG ) X-axis 2]
edge of the trigger TARGET1 QL\IRGETz
symbol CchB |
» Back edge of the trigger Ch A (_TRIG ) X-axis 1 [ X-axis 2|
symbol and the next TARGET1 \TﬁIRGETz
edge ChB |
« Front edge of the trigger Ch A [X-axis 1[X-axis 2 |(_TRIG )
symbol and the previous TJARGET1 \\TLAIRGETz
edge ChB | |
COMBINATION « Front edge of the ch A [X=axis [ TRIG )@ELIE
(Trigger on 2 trigger symbol \JARGET
consecutive symbols) chB | | |

TRIG TRIG

» Back edge of the trigger Ch A
symbol

ChB

* Edge between trigger Ch A
symbols

ChB

G X-axis |

| | \1;I-I\RGET

TRIG

\Tf\IRGET

BETWEEN
(Trigger on 2 symbols
separated by 1 symbol)

CRiG ) (CTRG)

* Front edge of the
symbol in between

2 triggers ChB

* Back edge of the Ch A

symbol in between

2 triggers ChB
* Front edge and back Ch A

edge of the symbol

in between 2 triggers ChB

Ch A (TRIG ) X-axis [ TRIG )

\T>AIRGET I I

(TRIG ) X-axis [(_TRIG )

\\IAIRGET

(CTRIG ) X-axis | TRIG )

\JARGET1\ TARGET2
|

Analysis Result Display

» Histogram display of all the data or extracted data and the list of the statistics
(average, jitter, and the number of data samples that are computed)

» Set the histogram color and switch the histogram vertical scale (Linear/Log)
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Specifications

Matrix Analysis

Data Extraction Condition Settings
Set the trigger and extracted data visually using the trigger bar

Trigger setting: Select from All, 1T to 14T, greater than or equal to the specified T

symbol, less than or equal to the specified T symbol,

Selectable trigger and extracted data:
» When the extracted data is pulse width

Odd, and Even

Trigger Extracted Data (TARGET)
SINGLE * 2 symbols before the Ch A [ Y-axis | X-axis [ TRIG )
(Trigger on a single trigger
symbol) TARGET TARGET
TRIG « 2 symbols after the ChA (_TRIG )] Y-axis | X-axis |
trigger
TARGET TARGET
Matrix display image
Y-axis
A 8T
T
6T
5T
4T
3T
3T aT 5T 6T T 8T
P X-axis
» When the extracted data is A-to-B time interval
Trigger Extracted Data (TARGET)
SINGLE . * 2 front edges of the Ch A [ Y-axis [ X-axis [_ TRIG )
(Trigger on a single trigger symbol TARGET1\_TARGET2
symbol) CchB | | |
TRIG
* Front edge and back Ch A [ Y-axis [ TRIG ) X-axis |
edge of the trigger TARGET1\ TARGET2
symbol chB | | |
* 2 back edges of the ChA (TRIG ) Y-axis | X-axis |
trigger symbol TARGET1\ TARGET2
ChB | pertiaa
Not specified * Edge in between ChA [ Y-axis | X-axis |
2 symbols \TﬁRGET
chB | | |

Analysis Result Display Using Statistics

+ Display the statistics of the extracted symbol (before and after the trigger)

+ Select the statistics from average, deviation, and jitter
+ Set the jitter unit to % or ns
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Specifications

Analysis Result Display Using Graphs
» Select from all point display (graph), deviation display, and jitter display
 All point display
+ Plot the measured average values of the extracted symbol (before and after the
trigger) on the X- and Y-axes (frequency can be displayed in color)
« Turn ON/OFF the average display, turn ON/OFF the trend display (vertical and
horizontal line plot)
+ Zoomed display possible
» Deviation display and jitter display

« Displays the deviation and jitter of the extracted symbol (before and after the trigger)

+ Set the display format to Bar, Pie, Rectangle

+ Set the jitter unit to % or ns

+ Set the threshold (two points) and display the three levels (Good, Safe, and Error)
using different colors

Other Display Settings
Comment Entry
Enter up to 50 characters
Auxiliary Display ON/OFF
Turn ON/OFF the graph time scale and explanatory note
Phase Adjustment through the Software (applicable only to data measured on the
TA720 with the measurement function set to pulse width A—A-to-B time interval)
—99.99 ns t0 99.99 ns (0.01 ns steps)
Zooming When Displaying the Matrix of All Points
Zoom in up to twice the size around the origin

Saving/Loading of Data
» Save and load the setup data of the software (.cfg extension)
» Save and load the loaded measured data (.mds extension)

» Save the statistics data (Triggered T, All Triggered T, matrix statistics) (.csv extension)

» Save and load the deviation center values set arbitrarily (.dev extension)

Setup Data Backup
Save the previous setup data (measured data excluded)

List Display of the Loaded Measured Data

List display of the file path (drive letter, directory, and file name) and communication path

(GP-IB and Ethernet)

Printing of Analysis Results
» Print the histogram analysis results and matrix analysis results (graph and sheet)
» Select the print color (black and white or color)
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Specifications

PC System Requirements

PC

PC running Microsoft Windows 98 SE, Windows NT Workstation 4.0, Windows 2000
Professional, or Windows XP Professional with at least 64 MB (128 MB for Windows
2000 or XP) of memory.

Operating System

Microsoft Windows 98 SE, Windows NT Workstation 4.0, Windows 2000 Professional, or
Windows XP Professional.

CD-ROM Drive

The drive is used to install the software.

Free Hard Disk Space

40 MB or more

Display

SVGA (800 x 600 resolution) or better (1024 x 768 or better recommended) and capable
of displaying 256 or more colors.

Printer and Mouse

Printer and mouse compatible with the OS that you are using.

GPIB Board/PCMCIA-GPIB Card (only when connecting the TA320/TA520/TA720
and the PC using GP-IB)

GPIB board or PCMCIA-GPIB card by National Instruments along with the driver must be
installed in the PC.

Ethernet Port (only when connecting the TA720 and the PC via the Ethernet
network)

Port for connecting to the Ethernet network.

FD Drive (only when opening data saved to a floppy disk)

One 31/2” floppy disk drive capable of reading 1.44 MB floppy disks (MS-DOS
compatible).
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Symbols

xN speed.... 2-3,2-4
cCFG s 5-4
.mds . .5-4
WV ..1-5
1-7(2T->8T) oo 21
8-16(EFM-Plus: 3T->14T . 2-1
8-17(EFM: BT->T1T) e 2-1
A

ACCUMUIALION ..o 1-1
Accumulation Mode ... ..1-5
Accumulation Setting .... 11
AAAIESS ..t 1-3
All Graph ....... 3-1,3-3
Analysis Mode...........ccceene .. 2-1
analysis results, printing of ...........ccccoeeeie ...5-5
applicable files for loading measured data .. .15
Ave. ..... .. 3-4
AVEIAGE ..o e 4-6
B

Bar oo 4-5,4-6
Bar Deviation ...........ceeeeeeeeiiieieee e 4-1,4-4,4-6
Bar JHEr ...veeeeeeiieeeee e 4-1,4-4
BaSE .. 2-4
BOFAEIS .. 4-6
C

Calculate .....cceveeeeeeeiciieeeeee e, 3-6, 3-7,4-8, 4-10
L0 5 SRR 2-3
Center ........... ...2-2,2-4
Center, SPaN .....cccviiiiiiiieie e 2-3
center value of deviation .2-2
Clear Data ......c.eeoveeiiiiieeieeeeeee e 1-4
Color ............. . 3-4,4-6,4-7,5-7
COMDINALION ... 3-7
Comm /Data File List . 1-6
Comment .......ccoeeeene ...2-6
comment, setting of ....... ...2-6
communication settings ............. .12
Communication/Data File List .... ..1-6
constant T ....ooeveveieeniineeeee .. 2-4
Copy Estimated Tto T ... .. 2-3
OOV e 5-2
D

Data Accumulation NUmber ..........cccocoeiniiiiiiniiceceeee 1-1
data accumulation number ................... 11
data accumulation number, setting of ............cccccoiiiii vii
data extraction conditions (histogram analysis), set .3-6
data extraction conditions (matrix analysis), settin............ 4-8
data extraction conditions, setting of ..........cc.coceiiiiiiinn. ix
data frequency .......cccccveevinieieieee .. 4-6
data POIANILY ...cocveeeeiiiieeeeee e 2-1
Deviation .......... 4-5
Deviation Color.........coouiiiiiiiieie e 4-6
Deviation Option ..o .. 2-3
display format of analysis results (histogram analys ......... 3-1
display format of analysis results (matrix analysis) ..... .41
Display grouped T (PW->TI)..... .4-6
Display menu ........cccccoeceenennen. Xiv
Display shape... ...4-6
DVD/USEF ...ttt 2-3

E

Easy T Setting .....cccvoiiiiiice e 2-3
EITOT e 4-7
Estimated T ..o 2-3
Ethernet ..o 1-2
EVEN oot 3-7,4-10
Explanatory Notes.................... 3-1,3-4,4-1,4-5
extraction mode, selection of ..........cccccvvvveeeeiiiiiiiieneeeee, 3-6
F

file, @liSt OF ... 1-6
File MENU ..o Xiii
G

Good . .4-6,4-7
GP-IB et 1-2
Gradation .......cooeeeiiie e 4-6
Graph ............ w.4-1,4-4,4-6
graph display ........ccocviiiieieee e 4-4
H

HEIp MeNU ... Xiv
HiIStOgram ..o 3-1,3-2
Histogram & Table ............ccccce... .3-1,3-2
histogram analysis, execution of ............cccccovriiiiiiinene 3-6
histogram display ..........cccooveoeiiiiniiee e vii, ix
Histogram Graph ...... .3-1,3-2
HOMZONTAL ... 4-6
|

installation, of software ... e XV
IP @AAreSS ..o 1-3
J

JIHEET e

Jitter Color ...

JEEEI UNIE <o

L

Left, RIgGht ...cooeeiee e 2-3
Left-BOtOM ..o 4-6
LOft-TOP oo 4-6
LIN@ PIOt ... 3-4
line plot of StatiStiCs ........cccvviveeiiec e 3-4
liNEAr SCale ........coceoiviiiiic e 3-5
Linkage .......... .2-4,3-4
list Of StatiStiCS .....vveeeeee 3-4
LOA .. 2-3
LOAG# ... 1-5
loading of measured data ..... .. vi,1-4
109 SCAIE ... 3-5
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M

MAIN WINAOW ...ttt e e e e e eeannnees ii
MaNUA ....overeieeeeeeee e

Mark Update ....
MALFIX oot

matrix analysis, execution of ...........ccccceviiiieniinneneceen, 4-8
matrix display
matrix table origin

MaALFIX-DEV. ..eeeieieiiieeeee et 4-3
Matrix-Graph .... .. 4-2
MatriX-JIEEI ....eoiiiiiieiee e
MEASUred data ........eeeveeeieiiiiiiee et

measured data, loading of
measured data, saving and loading of
MEAIA ...
menus, a list of .
MOUIALION ...
MOAUIAtIoON tYPE ....cvvieiiceee e
MONO TONE ...

N

NONE e 2-2

OPEIN e
Open From Communication .
OPLON i

P

PASSWOIT ...t 1-3
Percent(%) ...

phase adjustment ...
Phase adjustment resolution ...
PiE e

POIAIIEY .o
Positive(+) Error

Print Option ..o
Print Preview ....
Print SEIUP ..o
Printer Color ........ooiiiiiiiieeee e
pulse width modulation type, selection of .............c..cc...... 2-1

Save Measured Data & Setup
Save Setup Data .......cccoviieeiiiee
Save Statistics(All Triggered T) ... .
Save Statistics(Triggered T) ......ccocevireeriicieiccereeene
SCAIE .
Select T .... .
SElECE UNIE ...
Selected histogram ...
setup data
setup data, saving and loading of
SEtUP MENU ...
sheet display ..
Space Update
start and eXit ......oceoiiieiii s i
statistical calculation results, saving of ....
Statistics AvVerage .........ccovvvevvieeieicecesceeseeees
Statistics Deviation ..........ccoceeveeiieiiience e
Statistics Jitter
system requirements

T

T SYMDOI .o
table origin
Terms and Conditions of the Software License
time display (histogram analysis) .........ccccceoorviiiiicncnn. 3-3
time display (matrix analysis)
Time SCalI ..oooeeeeeeeeee e

TIME(NS) e

trigger (histogram), selection of ..

trigger bar (histogram analysis) .........ccccceovvvveviiieiiniienne
trigger bar (matrix analysis) ........ccccoceeniriiinienieeeeeee

V)

Use Deviation Option ..........ccccovreeiiiiciiiccicneeeceeee 2-3
USER .ottt 2-3
[UEST=T g =0 1SR 1-3
Vv

VEICAD .ooeeiiieeeeee e 4-6
VIBW MENU ..ottt ea e Xiii
w

WiNdow, SELtNG Of .....cc.eiiiiiiieee e 2-2
Z

4 oTo ] .1 OO PN 4-5
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